Chapter 2

Working with Projects
and Drawings

Learning Objectives

After completing this chapter, you will be able to:
* Create new projects and drawings

* Edit the properties of projects and drawings

* Add drawing descriptions

* Open existing projects

* Activate and close projects

* Add existing and new drawings to the current project
* Group the drawings of a project

* Rename, replace, and remove drawings from projects
* Assign description to a drawing

* Open project drawings

 Copy existing projects

* Understand the working of the PROJECT MANAGER
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INTRODUCTION

AutoCAD Electrical is a project-based software in which wiring diagrams related to each other
are grouped under a project. A project is a set of electrical wiring diagrams that form a project
file <project_name>.wdp. Each project is defined by an ASCII text file with .wdp extension. These
project files contain a list of project information such as project settings, project or drawing
properties, names and descriptions of drawing files, symbol library paths, and so on. You can
have an unlimited number of projects. However, only one project can be active at a time. The
list of these projects is displayed in the PROJECT MANAGER.

PROJECT MANAGER

Ribbon: Project > Project Tools > Manager

Toolbar: ACE:Main Electrical 2 > Project Manager
or ACE:Project > Project Manager

Menu: Projects > Project > Project Manager

Command: AEPROJECT

E The PROJECT MANAGER is used to create new projects, open existing projects, add

new drawings to a project, re-order drawing files, access existing projects, and modify

existing information in a project. By default, the PROJECT MANAGER is displayed

and docked on the left of the screen, as shown in Figure 2-1. If the PROJECT MANAGER is

not displayed by default, choose the Manager tool from the Project Tools panel of the Project
tab; the PROJECT MANAGER will be displayed.
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Figure 2-1 AutoCAD Electrical screen with the PROJECT MANAGER

Alternatively, choose the Project Manager tool from the ACE:Main Electrical 2 toolbar to display
the PROJECT MANAGER. The PROJECT MANAGER is similar to other AutoCAD Electrical
tool palettes. You can dock the PROJECT MANAGER at a specific location on the screen. Also,
if you do not want to use the project tools, you can hide the PROJECT MANAGER.
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The PROJECT MANAGER is divided into two tabs: Projects and Location View. The options
in both these tabs are discussed in detail in this chapter.

Projects TAB

In the PROJECT MANAGER, the Projects tab is chosen by default, refer to Figure 2-1. When
you double-click on the title bar of the PROJECT MANAGER, it gets undocked and is displayed
separately on the screen, refer to Figure 2-2. When you right-click on the title bar of the undocked
PROJECT MANAGER, a shortcut menu is displayed, as shown in Figure 2-3. You can change
the appearance, location, and display settings of the PROJECT MANAGER by choosing the
respective options from the shortcut menu.
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Figure 2-2 The undocked Figure 2-3 The shortcut menu displayed by
PROJECT MANAGER right-clicking on the title bar of the PROJECT
MANAGER

When you double-click on a project name in the Projects rollout, a list of drawings associated
with the project will be displayed. Also, the details of the selected project will be displayed in the
Details rollout of the PROJECT MANAGER, as shown in Figure 2-4. The name of the active
project will appear in bold text in the Projects rollout of the PROJECT MANAGER.

When you right-click on a drawing name, a shortcut menu will be displayed. You can use the
options in this shortcut menu to open, close, copy, remove, replace, rename, or access other
editing options to modify the drawing file. These options are discussed in detail later in the
chapter. You can open a drawing file by double-clicking on it in the PROJECT MANAGER
and the corresponding drawing file name will appear in bold text in the Projects rollout of the
PROJECT MANAGER.
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Note
You cannot create two projects with the same name in the PROJECT MANAGER. Moreover by
using the PROJECT MANAGER, you can switch to different projects and change their settings.

Opening a Project  BEROZEES -
You can open an existing project by using the Open %/| [NFPADEMO ] ¢
Project button from the PROJECT MANAGER. On Projects o F
doing so, the Select Project File dialog box will be 1= NFPADEMO =

displayed. Next, select the existing project from this dialog - ©F0 SCHEMATIC

box and choose the Open button; the selected project’s -E0 PANEL

name will be automatically displayed in the Projects rollout s EXTRA LIBRARY DEMO L
in bold text and it will become an active project. g5 POINTZPOINT g
& =l WDDEMO =
Creating a New Project e ==
Command: ACENEWPROJECT File Name: NFPAdemo.wdp
\CADCIM
»,  You can create a new project by choosing the New ' e E 2019\AeData
g Project button from the PROJECT MANAGER. On

doing so, the Create New Project dialog box will be
displayed, as shown in Figure 2-5. Alternatively, use the
ACENEWPROJECT command to create a new project.
Different options in the Create New Project dialog box are
discussed next.

PROJECT MANAGER

enu\Supportiuser

A\NFPADEMO.mdb

>

Figure 2-4 The PROJECT
Name MANAGER displaying the Details
The Name edit box is used to enter a name for the project.  rollout
On doing so, the .wdp extension will be automatically added
to the file name and displayed under the Create Folder with Project Name check box.

Location

The Location edit box is used to specify the location for saving the project. You can also choose
the Browse button on the right of the Location edit box to specify the location for saving
the project file (wdp file). By default, C:\Users\User Name\Documents\AcadE 2019\AeData\proj| is
displayed in the Location edit box, refer to Figure 2-5.

Create Folder with Project Name

The Create Folder with Project Name check box is selected by default in this dialog box. As a
result, a folder with a name identical to the project name will be created. Also, the new project
will be saved in that folder. The path of the folder will be the same as that defined in the Location
edit box. If you clear the Create Folder with Project Name check box, a separate folder will not
be created for the project.

Copy Settings from Project File

You can also copy the settings from an existing project and apply it to a new project. To copy
the settings from the existing project file, specify the name and location of the existing project
file in the Copy Settings from Project File edit box. Alternatively, choose the Browse button on
the right of this edit box; the Select Project File dialog box will be displayed. Select an existing
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project file and then choose the Open button; the settings of the specified project will be applied
to the new project and the location of the specified project will be displayed in the Copy Settings
from Project File edit box. By default, C:\Users\User Name\Documents\AcadE 2019\AeData\proj)
NFPAdemo\NFPAdemo.wdp is displayed in the Copy Settings from Project File edit box.

Create Mew Project @
Name:
|
Location:
C:\Users\CADCIM\DocumentsAcadE 2019 \AeData'\proj®

[¥] Create Folder with Project Name
CAUsers\CADCIM \Documents"AcadE 2015 AeData“proj'

Copy Settings from Project File:

C:\Users\CADCIM\Documents'AcadE 2019 Az Data'proj* NFP Adema* NFF Ademo.wdp
OK - Propees... oK [ Cancel | [ hHep |

Figure 2-5 The Create New Project dialog box

Descriptions

The Descriptions button is used to add a description to the project. Choose the Descriptions button;
the Project Description dialog box will be displayed, as shown in Figure 2-6. In this dialog box,
you can enter a description of the new project up to 12 lines per page. If you want to add more
than 12 descriptions, click on the > button at the bottom of this dialog box. To include the
description in the reports, select the in reports check box on the right of each description line.
Note that the descriptions thus added will be included in the report headers of the report file
and the title blocks of the drawing. Now, choose the OK button from this dialog box to save
the changes made and exit the dialog box. The concept of report generation, title blocks, and
Project Description dialog box is discussed in detail in the later chapters.

OK

The OK button of the Create New Project dialog box will be activated only if you enter the
name of the project in the Name edit box. Choose the OK button; the project that you created
will be added to the current project lists in the PROJECT MANAGER. Also, it will become an
active project and its name will appear in bold text in the PROJECT MANAGER.

OK-Properties

The OK-Properties button will be activated only if you enter the project name in the Name
edit box. Choose the OK-Properties button; a new project will be created and the Project
Properties dialog box will be displayed. This dialog box is used to modify project settings,
components, wire numbering, cross-references, styles, and drawing formats. All information
defined in the Project Properties dialog box is saved to the project definition file (.wdp) as
project and drawing defaults. Next, choose the OK button from this dialog box to exit from it.
The options in the Project Properties dialog box are discussed later.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

2-6 AutoCAD Electrical 2019 for Electrical Control Designers
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Figure 2-6 The Project Description dialog box

Note

You can also create a new project by right-clicking inside the Projects rollout and then choosing
the New Project option from the shortcut menu displayed or by selecting the New Project option
from the Project selection drop-down list in the PROJECT MANAGER. You will learn more
about 1t later in this chapter.

o

Working with Drawings

In the previous topic, you learned to create new projects using the PROJECT MANAGER. Now,
you will learn to create new drawings within an active project.

You can add any number of drawings to your project at any time. A project file can have
drawings located in different directories. But, it is recommended that you save your drawings
and project file (.wdp) in the same folder. When you create a new drawing, an invisible smart
block, WD_M, will automatically be added to your drawing at location 0,0. The WD_M block
defines drawing settings. These settings may be different from the project settings. Thus, you can
have different settings for difterent drawings in a single project. Also, each AutoCAD Electrical
drawing should contain only one copy of invisible WD_M block. If multiple WD_M blocks are
present in the drawing, the settings may not be stored and read consistently. Also, note that the
drawing to be created will automatically get added to the active project.

Creating a New Drawing
Command:  ACENEWDRAWING

The New Drawing button is used to create a new drawing file. To do so, choose the New
Drawing button from the PROJECT MANAGER; the Create New Drawing dialog box
will be displayed, as shown in Figure 2-7.
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Create Mew Drawing @

Drawing File
Name:

[7] For Reference Only

Location: C:sers\CADCIM\Documents' AcadE 2019'AzData\proj\NFF Ademo
CUsers\CADCIM \Documents'AcadE 2015 AeData"proj'\NFP Ademo

Description 1: -
Description 2: -
Description 3: -

|EC - Style Designators
Project Code:

Installation Code:

[ Drawing. .. ] [ Project.... ]

Location Code:

[ Drawing. .. ] [ Project.... ]

Sheet Values
Sheet: Section: -

Drawing: Sub-Section: -

OK - Propetties. . 0K [ cancel | [ Heb |

Figure 2-7 The Create New Drawing dialog box

Alternatively, invoke this dialog box by using the ACENEWDRAWING command or by
right-clicking on the Projects rollout of the PROJECT MANAGER and then choosing the
New Drawing option from the shortcut menu displayed. The different areas and options in
this dialog box are discussed next.

Drawing File Area

The options in the Drawing File area are used to specify the name of a drawing file, the
template file to be used in the drawing, the location to save the drawing, and the description
for the new drawing file. The options in this area are discussed next.

Name: Enter a name for the new drawing in the Name edit box; the .dwg extension will
automatically be added to the drawing name. Note that the OK and OK - Properties buttons
will be activated only after entering the name of the new drawing in this edit box.

Template: This edit box is used to specify the path and name of a template drawing (.dwt)
for creating drawing file. Alternatively, you can choose the Browse button; the Select
template dialog box will be displayed. Select the template drawing from this dialog box
and choose the Open button; the location of the template drawing will be displayed in the
Template edit box.
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/ Note
@ After specifying the template in the Template edit box, next time when you create a new drawing,

the template entered previously will automatically get displayed in the Template edit box. If this
edit box is left blank, AutoCAD Electrical will use the default acad.dwt file.

For Reference Only: The reference drawings are used for coversheets, terminal plans,
and other non-electrical layouts in a project. These drawings save the processing time of
AutoCAD Electrical functions. To create a reference drawing, you need to select the For
Reference Only check box. On doing so, the reference drawing will be included in the
project-wide plotting and title block update operations. All other electrical smart functions
such as cross-referencing, automatic tagging, reporting, and so on will be non-functional.
By default, the For Reference Only check box is cleared.

Note
The color of the reference drawing icon displayed on the left of the drawing name in the
PROJECT MANAGER s gray.

Location: The Location edit box is used to specify the location of a new drawing. The
directory of the active project file is specified by default in the Location edit box. Alternatively,
choose the Browse button on its right to specify different location for the new drawing. If you
leave the Location edit box blank, the drawing file will be created at the same location as that
of the active project. Note that you cannot create duplicate drawings at the same location.

Description 1-3: The Description 1, Description 2, and Description 3 edit boxes are used
to enter description for a drawing. In these edit boxes, you can enter up to 3 description lines
for a drawing file. You can also specify the description for a drawing by selecting it from the
description drop-down lists. But this is possible only if you have entered description in the
earlier drawings. The description thus entered will be displayed in the title block updates
and custom drawing properties.

OK

The OK button will be activated only if you enter a drawing file name in the Name edit box.
When you choose the OK button, the new drawing gets automatically added at the bottom
of the list in the active project and it appears in bold text. To view the drawing file, expand
the active project by double-clicking on the project name.

OK - Properties

The OK - Properties button will be activated only if you enter a drawing name in the Name
edit box of the Drawing File area. Choose the OK - Properties button; a drawing file will
be created at the specified location and also the Drawing Properties dialog box will be
displayed, as shown in Figure 2-8.

This dialog box is used to define settings and options for a drawing. The options in the
Drawing Properties dialog box will be discussed in the later chapters. The changes that you
make using this dialog box will be saved as attribute values on the drawing’s invisible WD_M
block. Choose the OK button from the Drawing Properties dialog box; the drawing will be
created and will appear in bold text at the bottom of the project list of the active project in
the PROJECT MANAGER.
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Drawing Properties @
Drawing Settings | Components I Wire Numbers I Cross-References | Styles | Drawing Format
Drawing:  C\Users\CADCIM \Documents'\AcadE 2015 AeDataproj \NFP Ademo 'z .dwg

Drawing File

Project: NFPADEMO

Description 1: - Picks>
Description 2: -
Description 3: -

[] For Reference Only

|EC - Style Designators

Project Code:
Installation Code:
| Drawing... | [ Project.. |
Location Code:
| Drawing... | [ Project.. |
Sheet Values
Sheet: Section: -
Drawing: Sub-Section: -
[ ok ][ canesl |[ Heb

Figure 2-8 The Drawing Properties dialog box

Note

Mentioning information in the Description edit boxes, the IEC-Style Designators area, the
Sheet values area, as well as choosing the OK - Properties button is optional. You can also edit
any of these fields later in the Drawing Properties dialog box.

Tip

The IEC style designators are widely used when you are using the IEC drafting standard.
You must be aware of the drafting standards used in AutoCAD Electrical. The software
has been designed to use seven International Drafting Standards which are listed below:

1. Joint Industrial Council ---- JICI1/JIC125 (USA)

2. International Electrotechnical Commussion ---- IEC2/IEC 60617 (Europe, UK)
3. Japanese International Standard ---- J1S2 (Japan)

4. Guobiao Standard ---- GB2 (Chinese)

5. Australian Standard ---- AS2 (Australia)

6. Institute of Electrical and Electronics Engineers Standard ---- IEEE 315/315A
7. National Fire Protection Association Standard ---- NFPA (USA)
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Adding a New Drawing to the Inactive Project

You can add a new drawing to the inactive project using the PROJECT MANAGER. To do so,
choose the New Drawing button from the PROJECT MANAGER; the Create New Drawing
dialog box will be displayed. Enter the required information in this dialog box, as explained
earlier and then choose the OK button; a new drawing will be created. Also, this drawing will
be automatically added to the active project and will appear in bold text at the end of the
Project Drawing list. Next, to add this drawing to an inactive project, right-click on the inactive
project name and choose the Add Active Drawing option from the shortcut menu displayed;
the Apply Project Defaults to Drawing Settings message box will be displayed, as shown in
Figure 2-9.

Apply Project Defaults to Drawing Settings @

Do you want to apply the Project Default Values to the Drawing Settings?

e [ % [ o]

Figure 2-9 The Apply Project Defaults to Drawing Settings message box

Choose the Yes button from the Apply Project Defaults | x - .
to Drawing Settings message box; the default (v BHES - EE& -

values of the project will be added to the WD_M block | ¥ [@NrPADEMC -] §
definition of the newly added drawing. If you choose ﬂfﬁ_—" £
the No button, the new drawing will retain its existing B4 Close
settings. Choose the Cancel button to exit the G P Expand Al
command. el W Collapse All
Add Subfolder

Note Flatten Structure

You. can have a single drawing in multiple Descriptions.—

projects.

Title Block Update...

Drawing List Report...
Adding Existing Drawings to the Current
Project

You can also add the existing drawings to the current
project. To do so, right-click on the project name in
the Projects rollout of the PROJECT MANAGER,; Add Drawings..

a shortcut menu will be displayed, as shown (e St B
in Figure 2-10. Choose the Add Drawings option Remove Drawings...
from the shortcut menu; the Select Files to Add
dialog box will be displayed, as shown in Figure 2-11.

Flip DWG Name to Lower Case
Flip DWG Name to Upper Case
Sort...

MNew Drawing...

¥ PROJECT MANAGER

Task List...

In this dialog box, select the desired project folder REITER D>
from the Look in drop-down list and then select Settings...

drawings to be added to the project. Next, choose Exception List...

the Add button; the Apply Project Defaults to Properties...

Drawing Settings message box will be displayed,

refer to Figure 2-9, Figure 2-10 The shortcut menu displayed

by right-clicking on the active project name

If you choose the Yes button, the default values of in the PROJECT MANAGER
the project will be added to the WD_M block definition of the newly added drawing. But if
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you choose the No button, the new drawing will retain its existing settings. Also, the selected
drawings will be added to your project and will appear at the end of the Project Drawing list.

A Select Files to Add ==
Look in: [ . NfpaDemo v] & E} @ i El Views + Tools =

e Name Preview
ey =

S peEmon

= S pEmon2

L.‘] S pemooz

= pemood

= pemoos

]‘;‘- = pEmoos

= pEmoo7

= pEmoos

! DEMO09

File name: | - Add
Files of type: [meings (*dwa) - H Cancel ]

Figure 2-11 The Select Files to Add dialog box

Note
You can select multiple drawing files at a time from the Select Files to Add dialog box by pressing
the SHIFT or CTRL key.

Working with Project Drawings

You can group drawings, remove drawings, assign description to drawings, preview drawings,
configure the drawing list display, and so on by using the PROJECT MANAGER. Also, you can
access the existing project and modify its related information using the PROJECT MANAGER.

Grouping Drawings within a Project
You can group the drawings in a project in two ways: grouping using section/subsection and
grouping using subfolders. These methods are discussed next.

Grouping Drawings Using Section/ Subsection

You can create a group of drawings within a project list by assigning the section and
sub-section codes to each drawing. To do so, expand the project by double-clicking on its
name, if it is not already expanded; the drawings in that project will be displayed. Next,
right-click on the drawing file; a shortcut menu will be displayed. Choose Properties >
Drawing Properties from the shortcut menu; the Drawing Properties dialog box will be
displayed, refer to Figure 2-8. In this dialog box, the Drawing Settings tab is chosen by
default. Enter the required section and sub-section codes for the drawing in the Sheet Values
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area and choose the OK button; the section and sub-section codes will get assigned to the
drawing file. Similarly, you can repeat the same procedure for each drawing that you want
to group together, but ensure that the same section and sub-section codes are assigned to
all of them.

Grouping Drawings Using Subfolders

You can create subfolders within a project to organize the drawings. To create a subfolder,
right-click on the project; a shortcut menu will be displayed. Choose Add Subfolder from
it; a subfolder with the name NEW FOLDER will be created at the bottom of the drawing
list. Rename it with a suitable name. Now, you can drag and drop the drawings available
in the project into the subfolder. When you right-click on the subfolder; a shortcut menu
will be displayed. The options in the shortcut menu are used to create and add drawings,
rename the subfolder, and so on. You can add any number of subfolders in a project. Also,
you can add subfolders within a subfolder.

You can also remove all the subfolders from an active project. To do so, right-click on an
active project and choose Flatten Structure from the shortcut menu displayed; the Flatten
Project Structure message box will be displayed warning you that if the process of flattening
is continued, you will not be able to revert back the changes again. Note that when you use
this option only subfolders are removed and the drawings are retained in the project.

After creating a group of drawings and subfolders, the project-wide tagging, cross-referencing,
and reporting functions can be performed on the whole project or a part of the drawing
set, using the section, sub-section coding, and subfolders.

Changing the Order of Drawings in a Project

In the Project Drawing list, the drawings created are arranged in the same sequence as they are
processed by AutoCAD Electrical during the project-wide tagging and cross-referencing operations.
However, you can change the order of the drawings present in a project by dragging and dropplng
the drawings at the required place in a sequence. You can also reorder the drawings by movmg
them between two subfolders of a project. Note that you cannot reorder the drawings by moving
them between two projects. You can press the CTRL or SHIFT key to select multiple drawings.

You can also sort the drawings in a project to change their order. To do so, right-click on the
project name and choose the Sort option from the shortcut menu displayed. If the project
contains subfolder(s), the Sort Options message box will be displayed showing four different
combinations of options to sort the drawings in the project folder and its subfolder(s), refer to
Figure 2-12. Choose one of these options as per your requirement; the Sort dialog box will be
displayed, as shown in Figure 2-13.

You can sort out the drawings in different ways depending upon the options selected from the
Sort dialog box. You can select the required option from the Primary sort, Secondary sort,
Third sort, and Fourth sort drop-down lists. These drop-down lists include REF (reference
status), SEC (section code), SUBSEC (sub-section), and FILEPATHANDNAME (file path and
name) options.

Some projects do not contain subfolder(s). If you right-click on such a project and choose the
Sort option from the shortcut menu displayed; the Sort dialog box will be displayed, refer to
Figure 2-13.
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Sort Options @
.:ﬁ. How would you like to handle the subfolders?

There are several different combinations of options to cheese from when dealing with subfolders
during a sort:

+ Move folders to top, sort files in this folder only
<+ Move folders to top, sort files in this folder and subfolders
+ Move folders to bottom, sort files in this folder only

< Move folders to bottom, sort files in this folder and subfolders

7] Always perform my current choice

Figure 2-12 The Sort Options message box

Sort @

Primary sort Secondary sort Third sort Fourth sort

REF -] [sec -] [suesec -] [FILEPATHANDNAME |

Figure 2-13 The Sort dialog box

After setting the required parameters, choose the OK button from the Sort dialog box; the dialog
box is closed and the drawing displayed in the list will be arranged according to the options
selected from the drop-down lists.

Removing a Drawing from a Project
You can remove a drawing from a project using two methods. These methods are discussed next.

First Method

Right-click on the drawing name in the PROJECT MANAGER; a shortcut menu will be
displayed. Choose the Remove option from the shortcut menu; the PROJECT MANAGER
- Remove Files message box will be displayed. Choose the Yes button from the message
box; the drawing will be removed from the project, but it will not be deleted from the folder
where it is stored.

Second Method

Right-click on a project name; a shortcut menu will be displayed. Next, choose the Remove
Drawings option from the shortcut menu; the Select Drawings to Process dialog box will
be displayed, as shown in Figure 2-14. The options in this dialog box are discussed next.

Drawing: The Drawing radio button is used to display the path and the name of all drawings
in a project. This radio button is selected by default.

Description: Select the Description radio button; the description of all drawings will be
displayed in the top list of the Select Drawings to Process dialog box. Remember that the
description will be displayed only if you have entered the description in the Description
1/2/3 edit boxes in the Create New Drawing dialog box or in the Description 1/2/3 edit
boxes of the Drawing Settings tab in the Drawing Properties dialog box.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Select Drawings to Process @
@ Drawing () Description
Rief Subfolder Section  Sub-Section Project Drawing List s
SCHEMATIC C:Users\CADCIMDocuments®Acad. .. \Ae DataprolNFP Adem
SCHEMATIC C\Users\CADCIM \Documents'Acad. .\ Ae Data'proj\NFP Adem| =
SCHEMATIC C:Users\CADCIMDocuments®Acad. .. \Ae DataprolNFP Adem
SCHEMATIC C\Users\CADCIM \Documents'Acad. .\ Ae Data"proj\NFP Adem —
SCHEMATIC C:Users\CADCIMDocuments®Acad. .. \Ae DataprolNFP Adem
SCHEMATIC C:\Users\CADCIM \Documents'Acad. ..\ Ae Data"proj\NFF Adem
CrUCRMATIT A e T AU TR Dimmit srmimimdbn s mmid % Am Dt m i RICD A me
< i | r
by Section./sub-section ] [ by Subfolder
Rief Subfolder Section  Sub-Section Project Drawing List
4| 1 L
Select from the top list, K [y,
insert into the bottom list. DK fichy e

Figure 2-14 The Select Drawings to Process dialog box

Do All: Choose the Do All button to transfer all drawings from the top list to the bottom
list of the Select Drawings to Process dialog box.

Process: The Process button will be activated only if you select a drawing(s) from the top
list. This button is used to transfer the selected drawing from the top list to the bottom list.
To do so, select a drawing(s) and then choose the Process button; the selected drawing(s)
will be transferred from the top list to the bottom list of the Select Drawings to Process
dialog box. You can use the SHIFT or CTRL key to select more than one drawing at a time.

Reset: The Reset button will be activated only if you have transferred drawing(s) from the
top list to the bottom list. Choose the Reset button to reset the drawings to their original
positions in the dialog box.

Un-select: The Un-select button will be activated only if you select drawing(s) from the
bottom list. The Un-select button is used to transfer drawing from the bottom list to the
top list. To do so, select a drawing(s) from the bottom list and then choose the Un-select
button; the drawings will be moved from the bottom list to the top list. You can unselect
multiple drawings at a time by using the SHIFT or CTRL key.

by Section/sub-section: The by Section/sub-section button is used to select the drawings
that have been grouped by specifying their sections and sub-sections. To do so, choose
the by Section/sub-section button from the Select Drawings to Process dialog box; the
Select Drawings by Section/sub-section dialog box will be displayed. Specify the section
and sub-section codes in the Section and Sub-section edit boxes, respectively. Alternatively,
select the section and sub-section codes from the Section and Sub-section drop-down lists,
respectively. Next, choose the OK button from the Select Drawings by Section/sub-section
dialog box; the corresponding drawing(s) will be transferred from the top list to the bottom
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list. Note that the Section and Sub-section drop-down lists display the section and sub-section
codes only if you have entered the section and sub-section values in the Sheet Values area
of the Create New Drawing dialog box or in the Drawing Settings tab of the Drawing
Properties dialog box.

by Subfolder: The by Subfolder button is used to select the drawings that have been
grouped in subfolders. To do so, choose the by Subfolder button from the Select Drawings
to Process dialog box; the Select Drawings by Subfolder dialog box will be displayed. Select
the subfolder(s) from this dialog box and choose the OK button; the drawings from the
selected subfolder(s) will be transferred from the top list to the bottom list. Note that the
Select Drawings by Subfolder dialog box displays the subfolders only if you have added
subfolders in the project.

After selecting drawings from the Select Drawings to Process dialog box, choose the OK button;
the Remove Drawing(s) from Project List message box will be displayed. In this message box,
choose the OK button; the selected drawings will be removed from the project list. Note
that the drawings will instantly be removed from the project list, but they will not be deleted
permanently from the folder where they are stored.

Assigning a Description to a Drawing

You can assign a three-line description to each drawing listed in your project. To do so, right-click
on the name of a drawing in the project; a shortcut menu will be displayed. Next, choose
Properties > Drawing Properties from the shortcut menu; the Drawing Properties dialog box
will be displayed.

By default, the Drawing Settings tab is chosen in the Drawing Properties dialog box. Enter
a description for the drawing in the Description 1/2/3 edit boxes. You can also select the
predefined description for your drawing from the Description drop-down list. Note that the
predefined description will be available only if you have entered the description for any of the
drawings of a project, as shown in Figure 2-15. This figure shows the predefined descriptions listed
in the Description 1 drop-down list of the Drawing Properties dialog box. Next, choose the
OK button; the drawing file will be updated and the changes will be saved.

Drawing Properties @
Drawing Settings | Components | Wire Numbers I Cross-References I Styles | Drawing Format
Drawing:  C:\Users\CADCIM'Documents'AcadE 2015 AeData proj\MFPAdemo demaoll.dwg

Drawing File

Project: NFPADEMO

Description 1: Flow and Interconnection diagram, 140 list H [ Pickz> ]
o 3phase motor contrel, Control circuit -

Deseription 2: Corttrol schematic

Description 3: Main Control Panel layout
Operator Station layout
[T For Referenc: PLC 140 - Input Slot 5, Output Slet &
PLC 140 - Inputs - Slat 1
IEC - Style Designz FLC /0 - Inputs - Slots 3, 4
Power supplies, /0 module feeds

Prriart MCada-

Figure 2-15 Partial view of the Drawing Properties dialog box
displaying predefined description
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; Note

@ The description specified in the Description 1, Description 2, and Description 3 edit boxes of
the Create New Drawing or Drawing Properties dialog box can be linked to the attribute in
the title block for automatic wpdate and will be discussed in the later chapters.

After adding description to a drawing, you can preview the description in the Details rollout of
the PROJECT MANAGER. These drawing details give a unique identity to the drawings based
on users requirement and helps users to search a particular drawing among multiple drawings
in a project file.

Switching between the Drawings of an Active Project

Ribbon: Project > Other Tools > Previous DWG
Project > Other Tools > Next DWG
Toolbar: ACE:Main Electrical 2 > Previous Project Drawing

ACE:Main Electrical 2 > Next Project Drawing

ACE:Quick Pick > Previous Project Drawing

ACE:Quick Pick > Next Project Drawing
Command: AEPREV and AENEXT

{}:I |I:£} | The Previous DWG and Next DWG tools are used to open the previous and next

drawings of an active project. Using these tools, you can view and switch between

various drawings of a project. To do so, open any drawing of the active project and
then choose the Previous DWG or Next DWG tool from the Other Tools panel of the Project
tab. Alternatively, you can choose the Previous Project Drawing or Next Project Drawing tool
from the ACE:Main Electrical 2 or the ACE:Quick Pick toolbar. On doing so, the currently opened
drawing will be closed and all changes made to it will be saved. Also, the requested drawing will
open. The currently opened drawing will appear in bold text in the project list.

Tip

Q 1o open all drawings of an active project in a new window without closing the original
drawing window, hold the SHIFT key while choosing the Previous Project Drawing or
the Next Project Drawing button.

Note
@ 1. You cannot view and switch among the drawings that are not associated with the active project.
2. You can use the PROJECT MANAGER lo preview the drawings easily using the Preview button.
3. If you move among various drawings using the up and down arrow keys, the selected drawing
will not open.

Configuring the Drawing List Display

The Drawing List Display Configuration button is used to configure the information
related to various drawings in the Projects rollout of the PROJECT MANAGER. This
button is used to display the required information such as drawing number, description,

and so on. By default, only the name of the drawing is displayed in the Projects rollout of the

PROJECT MANAGER, as shown in Figure 2-16. Choose the Drawing List Display Configuration

button from the PROJECT MANAGER; the Drawing List Display Configuration dialog box

will be displayed, as shown in Figure 2-17. The options in this dialog box are discussed next.
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Dlsplgy Optloqs Area .  EHRo EED -
The Display Options area displays Fhe predefined %| [NFpADEMO R
values that can be associated to a drawing. Projects o F

=-E SCHEMATIC -
demo0l.dwg L
demol2.dwg
demol3.dwg

Current Display Order

The Current Display Order area lists the order in

i
which the required display options will be displayed :emﬁ':““g L E
in the Projects rollout in the PROJECT MANAGER. d::ooﬁ:d:: £
The File Name option is displayed by default in this i% demo07.dwg

area. You can add other display options in this area by - PANEL L

lecting them from the Display Options area and then o woner e
selecting them from the Display Options area a e 5 POINTZPONT ;
choose >> button.

Figure 2-16 Partial view of the
S>> PROJECT MANAGER displaying the

The >> button is used to move only the selected display drawing files of the project

option from the Display Options area to the Current Display Order area.

Drawing List Display Configuration @
Display Options: Curmrent Display Order:
Installation Code (%) » vy File MName
Location Code (%L} =5

Section

Sub Section =
Sheet Mumber (%5)
Drawing Mumber (%01
Drawing Description 1

EJlawing EJesc:ription ? - << All

Separator Value Maove Up

@ Always show selection highlight
(7)) Show selection highlight only when active

Move Down

[ ok || cancel || Hep |

Figure 2-17 The Drawing List Display Configuration dialog box
All>>

The All>> button is used to move all display options from the Display Options area to the
Current Display Order area.

<<
The << button is used to move only the selected display option from the Current Display
Order area to the Display Options area.

<<All

The <<All button is used to move all display options from the Current Display Order area to
the Display Options area.

Separator Value

The Separator Value edit box is used to specify the character to be used as a separator between the
values in the listing. You can enter a character in the Separator Value edit box or use the default
character (-) in this edit box.
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Move Up
Choose the Move Up button to move the selected display option one step up in the Current
Display Order area.

Move Down
Choose the Move Down button to move the selected display X[
option one step down in the Current Display Order area. W BHRSERES -O
2| | NFPADEMO -8
Projects - §__'
Choose the OK button in the Drawing List Display = = NFPADEMO B
Configuration dialog box; the entire information UmSCHENATIC
. N . . . ™ demo(Ll.dwg - 0201 - Floy
related to drawings will be displayed in the Projects i demob2.dwg - 0202-3-pl | | 3
rollout, refer to Figure 2-18. I3 demo3.dug -0203 -Pow | |2
'™ demold.dwg - 0204 - Cor|= | | &
% demoD5.dwg - 0205 -PLC| | | 5}
Note @ demo06.dwg - 0206 - PLC
The drawing options arve displayed in the Current 18 demollF.dug - 0207 - PLC

. . . £ PANEL g
Display Order area in a particular sequence. The

same sequence is followed for their display in the Figure 2-18 Partial view of the
Projects rollout of the PROJECT MANAGER. Ifyou ~ PROJECT MANAGER displaying the
want to change the sequence, choose the Move Up or ~ drawing information

Move Down button.

Copying a Project

Ribbon: Project > Project Tools > Copy

Toolbar: ACE:Main Electrical 2 > Project Manager drop-down > Copy Project
or ACE:Project > Copy Project

Menu: Projects > Project > Copy Project

Command:  AECOPYPROJECT

The Copy tool is used to copy the entire project as well as copy the drawings present

E1  within that project. To do so, choose the Copy tool from the Project Tools panel of the

~ Project tab; the Copy Project: Step 1 - Select Existing Project to Copy wizard will be
displayed, as shown in Figure 2-19.

Copy Project: Step 1 - Select Existing Project to Copy @
Enter existing project name [ Copy Active Project ]

Mote: if the active drawing is one of those to be copied to a new project:
1. Cancel now.
2. Open a different or a new drawing.
3. Re-start this command.

[ ok | [ cencel | [ Heb |

Figure 2-19 The Copy Project: Step 1 - Select Existing Project to Copy wizard

Note
@ Before copying drawings to a new project, you need to close all drawings of that project.
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Next, enter the name and path of the existing project in the Enter existing project name edit
box. Alternatively, choose the Browse button from this dialog box to select the existing project;
the Select existing project to copy dialog box will be displayed. Next, double-click on the
project folder that you want to copy. Select the project’s .wdp file and choose the Open button;
the name and path of the existing project will be displayed in the Enter existing project name
edit box. You can also choose the Copy Active Project button available in this dialog box to
copy the currently active project.

Choose the OK button; the Copy Project: Step 2 - Select path and name for new project wizard
will be displayed, as shown in Figure 2-20. Enter a name for the new project in the File name
edit box and select the path for the new project from the Save in drop-down list. By default, the
.wdp extension will be displayed in the Save as type edit box. Next, choose the Save button; the
Select Drawings to Process dialog box will be displayed, as shown in Figure 2-21.

A Copy Project: Step 2 -- Select path and name for new project IEI

Savein: , NipaDemo - @ ? 4 '

(=51

Nfpademo

File name: | - Save

Save as type: [‘_wdp v] ’ Cancel ]

Figure 2-20 The Copy Project: Step 2 - Select path and name for new project wizard

Select the drawing files that you want to copy in the project from the top list of this dialog box.
Next, choose the Process button; the selected drawings will be transferred from the top list of
the Select Drawings to Process dialog box to the bottom list. The other options in the Select
Drawings to Process dialog box have already been discussed. Choose the OK button from the
Select Drawings to Process dialog box; the Copy Project: Step 4 -- Enter Base Path for Project
Drawings wizard will be displayed, refer to Figure 2-22.

Note

In case, there is no drawing file in the project to be copied, then the Select Drawings to Process
dialog box will not be displayed and the AutoCAD Message message box will be displayed. Choose
the OK button in this message box; the Copy Project: Step 4 -- Enter Base Path for Project
Drawings wizard will be displayed.
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Select Drawings to Process @
@ Drawing  (7) Description

Ref Subfolder Section  Sub-Section Project Drawing List Il
SCHEMATIC C:h\Users"\CADCIM DocumentshAcad...\AeData"proj \NFP Adem
SCHEMATIC CAiUsers\CADCIM \Documents ' Acad.. \AeData'proj NFP Adem| =
SCHEMATIC C:h\Users"\CADCIM DocumentshAcad...\AeData"proj \NFP Adem
SCHEMATIC CiUsers\CADCIM \Documents'Acad...\AeData"proj NFP Adem —
SCHEMATIC C:h\Users"\CADCIM DocumentshAcad...\AeData"proj \NFP Adem
SCHEMATIC C:Users\CADCIM \DocumentsAcad...\AeData"proj NFF Adem
CrUCMATIC, 0] e T AU IR Dimmi s mimdbn s mmid % Am Dl m b iy RICD A

< i | "

‘ Pro f Reset f Un-select by Section/sub-section ] [ by Subfolder
Ref Subfolder Section  Sub-Section Project Drawing List
4| T 2

Select from the top list, —
insert into the hottom list. i Help View

Figure 2-21 The Select Drawings to Process dialog box

Copy Project: Step 4 -- Enter Base Path for Project Drawings @
C:4Users"CADCIM Documents\ AcadE 2019 AeData"proj NFPAdema', |

The base path above wil be substituted for this path in the existing project
cusershcadcimidocumentstacade 2019 aedata’proj\rfpademo*.

Copies of the drawings will be copied to this new path
If the directory path does not exist, it will be created.

Select Project-Related Files to be Copied

Title Block Setup {wdt) Location Codes {loc)
Project Line Labels {wdl) Installztion Codes (inst)
Component Description Defaults (wdd) Ratings Defaults {wdr)
Catalog Lookup Database {cat.mdb) Companent Tagging (wdk)
Footprint Lookup Database {ookup.mdb) Spreadsheet PLC 140 Utilty Settings (.wedi)
Famity Code Mapping (wd_fam dat) RSLogix Import Mapping (wdf)
Wire Color/Gauge Label (wdw) User Defined Attributes {wda)
Schematic Lookup Database (schematic_lookup .mdb) Terminal Audit Filter {wdn)

Figure 2-22 The Copy Project: Step 4 -- Enter Base Path for Project Drawings wizard

In this dialog box, enter the directory path where the new project will be saved. The directory path
will be created, if it does not exist. In the Select Project-Related Files to be Copied area, you
can specify the project related files that need to be copied to the project that you want to create.
Note that the project related files to be copied will be activated in the Select Project-Related
Files to be Copied area. To copy these files, select the check boxes on the left of the respective
files and then choose the OK button; the Copy Project: Step 5 -- Adjust new drawing file names
wizard will be displayed, as shown in Figure 2-23.
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Copy Project: Step 5 -- Adjust new drawing file names @

C:/Users/CADCIM/ Documents/AcadE 2019/AeData proj/NFP Ademo./dema(4.dwg
C:/Users/CADCIM/Documents/AcadE 2015/Ae Data/proj/MFPAdemo,/demo05 dwg
C./Users/CADCIM/Documents/AcadE 2015/Ae Data./proj/MFP Ademo,/demo 06 dwg

e

Figure 2-23 The Copy Project: Step 5 -- Adjust new drawing file names wizard

Choose the Edit button in this wizard to edit the file name and path of the selected drawing, if
needed. Similarly, choose the Find/Replace button to find or replace a drawing file name and
its path. Next, choose the OK button; the name of the new project will be displayed at the top
in the Projects rollout in bold text and will become the active project.

Deleting a Project

Ribbon: Project > Project Tools> Delete
Menu: Projects > Project > Delete Project
Command: AEDELETEPROJECT

EI The Delete tool or the AEDELETEPROJECT command is used to delete an

existing project and its drawings permanently. To do so, choose the Delete tool from
the Project Tools panel of the Project tab; the Select Existing Project to Delete dialog box will
be displayed, as shown in Figure 2-24.

A Select Existing Project to Delete @
Look in: , Proj - @ ? - v
Mame = Date
il Aegs 8/13/2

. Demo 8/14/2
. Extra Library Deme 8/14/2
. NfpaDemo 8/14,2
. Point2Paint 8/14/2

4| 1 +

Files of type: | *wdp v] [ Cancel ]

[ locate | [ FindFie.. |

Figure 2-24 The Select Existing Project to Delete dialog box

Enter the name of the project file to be deleted in the File name edit box. Alternatively, select a
project name from the list displayed in the Select Existing Project to Delete dialog box. Next,
double-click on the name of the project folder; if it exists. Select the project definition file(.wdp)
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and choose the Open button; the Project File Delete Utility dialog box will be displayed, as
shown in Figure 2-25. The options in this dialog box are discussed next.

Delete “.wdp” project list file Project File Delete Utility ==
The Delete"‘.wdp” project list file Cation
check box is used to permanently This utiity Delstes fles.
. . There is no "Unda”.
delete the selected project file with .wdp Itis permanent
extension.

[ Delete " wdp" project list file
o huzershe., Aprojhvestra library demobestra library demo.wdp

Delete project’s AutoCAD

- - [ Delete project's AutoCAD drawing files
drawing files

The Delete ProjeCt’S AutoCAD draWing Lizt Select from project's drawing file list
files check box is used to delete only the
drawing files of a project. Note that this T

check box will be activated only if the
related project consists of drawing files.

Figure 2-25 The Project File Delete Utility dialog box

List

The List button will be activated only if you select the Delete project’s AutoCAD drawing files
check box. Choose the List button; the Select Drawings to Process dialog box will be displayed,
refer to Figure 2-21. Select the drawings to be deleted from the drawing file list of the project.
Next, choose the OK button from the Select Drawings to Process dialog box; the Project File
Delete Utility dialog box will be displayed again. Choose the Delete Files button from the
Project File Delete Utility dialog box; the selected files will be deleted permanently, and you
cannot retrieve them.

Other Options in the PROJECT MANAGER

As discussed earlier, the PROJECT MANAGER lists the drawing files associated with each
project. You can change the settings of a project by using the PROJECT MANAGER, refer
to Figure 2-26. The major tools and rollouts in the PROJECT MANAGER have already been
discussed. The remaining ones are discussed next.

Buttons

Project selection drop-down list
Projects rollout

Project Drawing list
Details/Preview rollout

GU 0 ho =

Buttons
There are several buttons available in the PROJECT MANAGER such as Refresh, Publish/
Plot, and so on, see Figure 2-27. These buttons are discussed next.

Refresh

.. | The Refresh button is used to freshen the drawing list present in the
=#| PROJECT MANAGER.
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Buttons
Project selection drop-down list

Projects rollout

Project Drawing List

Details/Preview rollout

Figure 2-26 larious components of the PROJECT MANAGER

Project Task List

Refresh

Mew Drawing
Mew Proiect —
Open Project —

Project-Wide Update/Retag

Drawing List Display Configuration
Publish/Plot

— Help

|
BERSZERS -@

| MFPADEMO

| Projects

1
Projects

| =t NFPADEMO

Figure 2-27 Various buttons in the PROJECT MANAGER

Project task List

&

The Project Task List button will be activated only if there are pending updates for

a drawing file. The Project Task List button is used to execute the pending updates

on any drawing file modified in the active project. Choose the Project Task List
button from the PROJECT MANAGER or right-click on the active project; a shortcut menu
will be displayed. Next, choose the Task List option from the shortcut menu; the Task List

dialog box will be displayed. Select the drawing files that you want to update and choose
the OK button; the QSAVE message box will be displayed. Choose the OK button from the
QSAVE message box; the drawing(s) will be updated. The process of keeping the updates

pending at a certain stage in the drawing and executing these updates later using the Task

List option as well as options in the Task List dialog box are discussed in detail in Chapter 12.

Project-Wide Update/Retag

K

The Project-Wide Update/Retag button is used to update the related line
reference numbers, device tagging, cross-reference text, and signal reference

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

2-24 AutoCAD Electrical 2019 for Electrical Control Designers

updates on the selected drawing files in an active project. Choose the Project-Wide
Update/Retag button from the PROJECT MANAGER; the Project-Wide Update or Retag
dialog box will be displayed. Specify the required options in this dialog box and choose the
OK button; the Select Drawings to Process dialog box will be displayed. Now, select the
drawings that you want to process and choose the Process button. Next, choose the OK
button; the selected drawings will be updated. The options in the Project-Wide Update or
Retag dialog box will be discussed in detail in Chapter 6. You can also use the (WD_BUMP)
command to invoke the Project-Wide Update or Retag dialog box.

Publish / Plot
H Choose the Publish/Plotbutton from the Project
Manager; the Publish/Plot drop-down willbe | pursspe®m @ |

displayed, as shown in Figure 2-28. The options | [neeadewo Plot Project
. . Publish to WEB
in the drop'—down of the Publl§h/ Plot buttgn areused | UEL e e POE e D
to plot active drawings, publish the drawings of the £ £ SCHEMATIC e
¥ demolL.dwa o

active project to web, DWE, PDF, DWFx and zip the
active project. Choose the Plot Project option from the  Figure 2-28 The drop-down displayed
drop-down to batch plot one or more drawings in the oy choosing the Publish / Plot button
active project. The Plotting of drawings will be discussed

in detail in Chapter 12.

Help

@ When you choose the Help button from the PROJECT MANAGER, the AutoCAD
Electrical 2019 - Help window will be displayed. Alternatively, choose Help from

the Help menu to display the AutoCAD Electrical 2019 - Help window. This

window helps you understand different options, commands, and tools of AutoCAD Electrical.

Note
@ If you press F1 or use the HELP command, it will also display the AutoCAD Electrical 2019

- Help window.

Project selection Drop-down List © PROJECT MANAGER
The Project selection drop-down list is available at the BERSZEED O
top of the PROJECT MANAGER, as shown in NERADEMO E
Figure 2-29, and it consists of names of all open projects WODEMO
and following options: NFPADEMO
EXTRA LIBRARY DEMO
POINTZPOINT
1. Recent
2. New Project Recent..
3. Open Project New Project..
4. Open Project from Vault Open Project..

You cannot close any open project using the Project

Open Project from Yault..,

selection drop-down list. The other options in this Figure 2-29 The PROJECT

drop-down list are discussed next.

MANAGER displaying the Project
selection drop-down list

Recent

When you select the Recent option from the Project selection drop-down list, the Recent
Projects dialog box will be displayed. In this dialog box, you can view the recently opened
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projects, view the drawings of the selected project, remove the selected project, and find the
drawings from the recent projects list displayed in the Recent Projects dialog box.

New Project

The New Project option is used to create a new project. To do so, select the New Project
option from the Project selection drop-down list; the Create New Project dialog box will
be displayed. The options in this dialog box have already been discussed. Specify the
required options and choose the OK button; the new project will be created and will appear
in bold text on the top of the list in the Projects rollout. Also, the newly created project will
automatically become an active project.

Open Project

The Open Project option is used to open an existing project. To do so, select the Open
Project option from the Project selection drop-down list; the Select Project File dialog box
will be displayed. Next, select the required project from this dialog box and choose the Open
button; the selected project’s name will automatically be displayed in the Projects rollout
in bold text and the project will become an active project.

Open Project from Vault
The Open Project from Vault option is used to open a project from Autodesk Vault. Vault
is a repository where documents and files are stored and managed.

Projects Rollout

Thf? Projects rollout displays a li§t of all opened N BERcEEES®-O
projects. You can open as many projects as you want, % | [ NrPADENO [] &
but only one project can be active at a time. The Projects Tom

active project appears in bold text and is always o S
displayed at the top of the list in the Projects rollout. Collapse Al

When you right-click on the name of the active
project or on the project that is in bold text, a shortcut
menu will be displayed, as shown in Figure 2-30. The
options in the shortcut menu are discussed next.

Details
close Status: Accessi Flip DWG Name to Upper Case
The Close option is used to remove the project File Name: NFE Sort.
which is displayed in the Projects rollout. Location: CAUS  New Drawing...
YWAcadE 201904 .
Add Drawings...
Project Databa: Add Active Drawing
Expand A“ . . \App[}ca‘;aSREt‘)a Remove Drawings...
The Expand All option is used to expand a o :‘S"‘:;:o e
. . . . ] Task List...
project and subfolder(s) in a project, if any. 3| e
= | | Titlel: Sample Publish b
g Panel Layout Bl
Collapse All 5 Settings..
. . = Exception List...
The Collapse All option is used to collapse a = ceeen ™
A Properties...

project and subfolder(s) in a project, if any.

Add Subfolder
The Add Subfolder option is used to add a
subfolder to a project.

Add Subfolder
Flatten Structure

Descriptions...
Title Block Update...
Drawing List Report...

Flip DWG Name to Lower Case

Figure 2-30 The shortcut menu displayed
by right-clicking on the active project in the
PROJECT MANAGER
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Flatten Structure
The Flatten Structure option is used to remove subfolder(s) from the project to get a flat
drawing list in a project.

Descriptions

The Descriptions option is used to edit the description of an existing project. It is also used
to add description to a new project. To do so, choose the Descriptions option from the
shortcut menu; the Project Description dialog box will be displayed, refer to Figure 2-6.

As the Project Description dialog box displays unlimited lines, you can enter the description
as per your requirement. The information that you enter in these lines can be re-used in
the Component, Bill of Material, and Wire reports that are generated for the project or
mapped to title block of the drawing. Select the in reports check box from the Project
Description dialog box to include the project description line information in report headers
and title blocks, which will be discussed in detail in the later chapters.

Title Block Update

The Title Block Update option is used to update the information of the title block for the
entire project drawing set or for the active drawing. To update the title block information,
right-click on the active project; a shortcut menu is displayed. Choose the Title Block Update
option from the shortcut menu; the Update Title Block dialog box will be displayed, as
shown in Figure 2-31. The options in this dialog box will be discussed in detail in Chapter 12.
You can also update a title block by using the WD_TB command.

Update Title Block @I
Select Line[s) to Update [Project Desciiption Lines)

[T Tite 1: Sample Project - Schematics ] LINET3 [blark]

[ Title 2: [blank] [} LINE14 [blark]

O] Title 2: [blank] [T LINE1S [blank]

[T Job Number: [blank] [F] LIMEE [blark]

7] Date [blank] ] UNE1? [blank]

[] Engineer [blank] [F] LIME1B [blark]

[] Crawn By [blank] [ LME1S [blank]

] Checked By [blank] [T LINE2O [blank]

[] Scale [blank] [} LNEZ [blark]

7] umEtD [blank] O uME22 [blank]

71 LINET [blank] [F] LIME23 [blark]

7] umE1Z [blank] ] LINEZ4 [blank]

Select lines) ko update [these are per-drawing values]

] Drawing Descriptian: O 2 i [FP 1 L (Pl 2L values)

(] Drrawing Section: [Section in project] = Drawing [0 value)

[] Drawing Sub-section: [Sub-section in project] [C] Sheet (%5 value) [ Previous (%5 value] [C] Wewt (%5 value]
[T] Filename: Drawing1 Unper case ] Sheet masimum: D

] Fileestension: Drawingl.dwg

] Full Filename: C:AUsersh...ments\Drawingl.dwg [0 Reseauence shest %5 values

Activate each drawing to process

OF &ctive Drawing Only OFK Project-wide l Cancel ] l Help ] [ Wides ]

Figure 2-31 The Update Title Block dialog box

Drawing List Report
The Drawing List Report option is used to generate a report that lists the project drawing
information of title block such as file names, file date, time, sheet number, drawing
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descriptions, sections, and so on. To generate a report, choose the Drawing List Report
option from the shortcut menu or use the WD_DWGLST_PROJ command; the Drawing
List Report dialog box will be displayed. The options in this dialog box are used to extract
the new drawing list report, display previous drawing list report, and select format file for
report. You will learn more about the generation of reports in Chapter 9.

Task List

The Task List option will be activated only if an active project has pending updates on any
drawing file which is present within the active project and has been modified. Choose the
Task List option from the shortcut menu; the Task List dialog box will be displayed. The
options in the Task List dialog box will be discussed in Chapter 12.

Publish

When you right-click on an active project and move the cursor to the Publish option of the
shortcut menu, a cascading menu will be displayed, as shown in Figure 2-32. This cascading
menu consists of various options such as Plot Project, Publish To PDF/DWF/DWFx, and Zip
Project. Choose the Plot Project option to plot one or more drawings in the active project.
The Publish To PDF/DWF/DWFx, and Zip Project options are used to publish the project
to pdf, dwf, dwfx and to create the zipped file of a project, respectively.

x .
W BEHBSEREES @
£ -] =
@
Close
Expand All
Collapse All
Add Subfolder
Flatten Structure
Descriptions...
Title Block Update...
Drawing List Report...
Details Flip DWG Mame to Lower Case
Status: Accessibl Flip DWG Name to Upper Case
File Mame: MFPA Sort...
Location: C:\Use New Drawing...
dE 2019
W= s Add Drawings...
Project Database Add Active Drawing
\AppData\Roam
. \AutoCAD Electr Remove Drawings...
§ \Supportiuser\M Task List..
= S
= pat:elli_::mﬁ‘e P Publish ¥ PlotProject
= .
&= Settings... Publish to PDF/DWF/DWFx
[=}
= Exception List... ZIP Project
A Properties... I

Figure 2-32 Cascading menu displayed on
selecting the Publish option

Settings

When you choose the Settings option from the shortcut menu, the Current Settings dialog
box is displayed. This dialog box displays settings of a project and information about
AutoCAD Electrical environment.
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Exception List

When you choose the Exception List option from the shortcut menu, the Properties
Exception List dialog box is displayed, as shown in Figure 2-33. This dialog box displays the
list of drawing files that possess the properties different from the project definition file
(*.WDP). Figure 2-34 shows the Properties Exception List dialog box that will be displayed if
the settings of all drawing files of a project match with the settings of the project definition
file. Also, this dialog box displays that there are no exceptions.

Properties Exception List: NFPADEMO (25

These drawinals) have different properties than the project defaults. Use the Settings
I-_\ Compare function to display differences.

File Name: demo1.dwg
Status: Accessible u
Location: C:\Users\CADCIM \Documents®AcadE 2019 AeData"proj'NFP Ademo

13

m

File Name: demol2 dwg
Status: Accessible
Location: C:\Users\CADCIM\Documents’\AcadE 2015 AeData"proj'NFP Ademo

File Name: demol3.dwg
Status: Locked by CADCIM{CADCIM-PC)
Location: C:\Users\CADCIMDocuments‘AcadE 2015 AeData"prof\NFP Ademo

File Name: demol4 dwg

Status: Accessible
Location: C:4Users\CADCIM \Documents AcadE 2015\ AzData proj M FPAdema

Figure 2-33 The Properties Exception List dialog box

Properties Exception List: 1 @

All drawings match the project defaults.

Figure 2-34 The Properties Exception List dialog box



Working with Projects and Drawings 2-29

> Note

@ You can view the difference between drawing properties and project defaults. 1o do so, choose

) Settings Compare from the Projects menu or choose the Settings Compare button from the
Drawing Properties drop-down in the ACE:Main Electrical 2 toolbar; the Compare Drawing
and Project Settings dialog box will be displayed. This dialog box is used to compare the drawing
and project default settings.

Properties
On choosing the Properties option from the shortcut menu, the Project Properties
dialog box will be displayed, as shown in Figure 2-35. You can use this dialog box to edit
and modify the properties for project settings, components, wire numbers, cross-references,
styles, and drawing format. The editing of project properties will be discussed in detail in
Chapter 12.

Project Properties
Project Settings | Components I Wire Mumbers I Cross-References I Styles I Drawing Format

Project:  C:\Users\CADCIM“Documents'AcadE 2015 AeData proj NFP Ademo \NFPAdemo wdp

= Library and lcon Menu Paths
et )

D Schematic lcon Menu File

E Panel Footprint Librares

D Panel lcon Menu File

Remaove
Move Up

Maove Down

=l Catalog Lookup File Preference
@ Use component specific tables Other File... {none defined)
() Always use MISC_CAT table
71 Use MISC_CAT table only if component specific table does not exdst

=l Options
Tag / Wire Number / Wire Sequence Sort Onder:

Real time emor checking No Project Default -

Electrical Code Standard:
Default (National Blectrical Code) -

[ ok [ Canesl |[ Hel

Figure 2-35 The Project Properties dialog box
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/ Note

@ The options discussed above will be displayed if you right-click on an active project in the Projects
rollout. But if you right-click on an inactive project, a shortcut menu with the Activate option
will be displayed, as shown in Figure 2-36. If you choose this option from the shortcut menu, the
selected project will become active and will be displayed at the top of the projects list in bold text.

Project Drawing List

The Project Drawing list displays the drawings available in a project. If you double-click on a
project name in the Projects rollout of the PROJECT MANAGER, the drawings associated with
that project will be displayed. Right-click on a drawing file name; the editing options will be
displayed, as shown in Figure 2-37. Using these options, you can open, close, remove, rename,
and replace a drawing file. You can also edit the properties of a drawing by choosing Drawing
Properties from the shortcut menu, refer to Figure 2-37. The options in this shortcut menu are
discussed next.

N BERSEIERS -0

#| (weacewo ] & BERS I EESD -0

TX

Projects e #| [weaemo ] §
= NFPADEMO = = ;:
= I=-t=| NFPADEMO =
S e =R SCHEMATIC -
i WDDEM) Close. i L
1 er en

Expand All ) =

Collapse All

Add Subfolder
Details Descriptions.

Status: Accessib| Flip DWG Name to Lower Case
File Name: Extra
Flip DWG Neme to Upper Case

Location: C:\Us Sort..
\AcadE 2019\A
Dema Add Drawings. File Name: demo01.dwg

B Drawing Properties...
Apply Project Defaults

Copy
Location: Ci\Users\CADCIM Paste
\Documents\AcadE 2019\AcData
\proj\NFPAdemo

m

Project Databas:

Title 1; Sample
Hydraulic, e Exception List..

Settings Compare..

File Size: 117K (119852 bytes)
Last Saved: 1/30/2017 3:50:24 PM
Last Edited By: Autodesk

> PROJECT MANAGER
»  PROJECT MANAGER

Figure 2-36 The shortcut menu displaying Figure 2-37 The editing options available
the Activate option in the shortcut menu

Note
@ You can convert a drawing file into a reference drawing. 1o do so, right-click on the drawing
\ name and choose Properties > Drawing Properties from the shortcut menu; the Drawing
Properties dialog box will be displayed. Select the For Reference Only check box from the
Drawing Settings tab; the drawing file will be converted into reference drawing. However; its
extension (.dwg) will remain the same.

Open

On choosing the Open option from the shortcut menu, the selected drawing will open in a
new window and its name will appear in bold text in the Project Drawing list. Alternatively,
you can select a drawing file name and press ENTER to open the corresponding drawing.
You can also open a drawing file by double-clicking on it. The OPEN command is also used
to open a drawing file.

Close

Choose the Close option from the shortcut menu to close the current drawing file. This
option will be available only if the drawing file is open. You can also close a drawing file by
using the CLOSE command.
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Copy To

The Copy To option is used to copy the selected drawing to the same or another open
project. To do so, choose the Copy To option from the shortcut menu; the Copy To dialog
box will be displayed, as shown in Figure 2-38. Next, from the Save in drop-down list, select
the location where you want to copy the drawings. If you want to change the name of the
drawing file, enter the drawing file name in the File name edit box. Next, select the project
name from the Project drop-down list. Choose the Save button; the Apply Project Defaults
to Drawing Settings message box will be displayed. Choose the Yes button in the message
box to apply the project default values to the newly added drawing’s WD_M block definition;
the selected drawing(s) will be copied to the specified project. If you want the new drawing
to retain its existing settings, choose the No button.

A CopyTo @
Savein: , MfpaDemo - @ ? ¥ -
T MName = Date r
che eI B/id/:
Recent Places DEMO0L 1/30/;
! DEMO02 1730/
DEMOO3 1430/
Desktop DEMO04 1/30/;
— DEMO05 1730/
w;QJ DEMO0G 1730/
Libraries DEMOO7 1,30/
DEMO0& 1/30/
Eh,...g DEMO0S 130/
Computer
w
H 4| i b
Metwork
File: name: demol -
Save as type: [DWG Files (".dwg) v] ’ Cancel ]
Project: [NFPADEMO -]

Figure 2-38 The Copy To dialog box

Remove
Choose the Remove option from the shortcut menu to remove the selected drawing from
the current project. This option does not remove the drawings permanently.

Replace

The Replace option is used to replace the selected drawing with the desired one. To do
so, choose the Replace option from the shortcut menu; the Select Replacement Drawing
dialog box will be displayed, as shown in Figure 2-39. Next, select the drawing file and
choose the Select button; the Apply Project Defaults to Drawing Settings message box
will be displayed, refer to Figure 2-9. Choose the Yes button to apply the project default
values to the newly added drawing’s WD_M block definition. If you want the new drawing
to retain its existing settings, choose the No button; the drawing file will get replaced with
the selected drawings. This drawing will be displayed in the Project Drawing list. Also, note
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that if the drawing is already present in the project, it will display the message that drawing
is already present in the project.

Rename

The Rename option is used to rename the selected drawing. To do so, choose the Rename
option from the Project Drawing list; the name of the selected drawing will be replaced by
an edit box. Enter a new name in the edit box to rename the drawing.

A Select Replacement Drawing @
Look in: [ . NfpaDemao v] & E} @ i E:'_ Views - Tooks -

1= MName Preview
ol B

S pemoot

= S pEmooz2

[.‘] FS pemoos

= peEmood

S pEmoos

1‘;‘- = pemoos

= pEmaoo7

S pemoos

! S pemooe

4 I 2

File name: - Select

Files of type: [meings (*dwg) - H Cancel ]

Figure 2-39 The Select Replacement Drawing dialog box

Drawing Properties

The Drawing Properties option is used to change the drawing settings, component tag
format, wire number format, cross-reference format, styles, and drawing format. Also, you
can edit, assign, and remove the section and sub-section codes of a drawing. To do so, choose
Properties > Drawing Properties from the shortcut menu; the Drawing Properties dialog
box will be displayed. In the Drawing Properties dialog box, you can assign descriptions
to the drawing files. Note that each individual drawing can have its own drawing settings
for designing purpose.

Apply Project Defaults

Choose the Apply Project Defaults option from the shortcut menu to apply the project
default settings of the project to the new drawing files, if it was not done while creating the
drawing files.

Copy
You can copy drawing settings and options from one drawing to one or more drawings by
choosing the Copy option from the shortcut menu.
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Note

The drawing-specific information that is displayed in the Drawing Settings tab of the
Drawing Properties dialog box cannot be copied from one drawing to anothes; vefer to Figure 2-§.

Paste

Choose the Paste option from the shortcut menu to apply the copied drawing settings as

well as other options from one drawing to other selected drawing(s).

Settings Compare

The Settings Compare option is used to compare the drawing with its project settings. To
do so, choose the Settings Compare option from the shortcut menu; the Compare Drawing
and Project Settings dialog box will be displayed, as shown in Figure 2-40. This dialog box
displays the differences between the drawing settings and their associated default values in
the project definition file (wdp). See Figure 2-40, where demo01.dwg is the drawing name

and NFPADEMO is the project name.

Compare Drawing and Project Settings: demoll.dwg Yersus NFPADEMO @
() Show Al
® Show Differences Select All Match Project | | Match Drawing |
Settings Description Drawing Project
Wire layers BLK® WHT* RED*, GRN*, WIRES*WIRES
[ ok | [ cameel | [ Heb |

Figure 2-40 The Compare Drawing and Project Settings dialog box

Details/Preview Rollout

The Details/Preview rollout displays the details of the selected project or drawing as well as the
preview of the selected drawing. The Details and Preview rollouts shown in Figure 2-41 and

Figure 2-42, respectively are discussed next.
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Details [ER I

Status: Accessible
Sheet: Preview BE -

Description: Control schematic
File Name: demold.dwg

Location: Ch\Users\CADCIM\Decuments
“AcadE 2019AeData\prej\NFPAdemo

File Size: 108KB (110681 bytes)
Last Saved: 1/30/2017 3:50:24 PM
Last Edited By: Autodesk

Figure 2-41 The PROJECT MANAGER Figure 2-42 The PROJECT MANAGER
displaying the Details rollout displaying the Preview rollout

Details
) The Details button is used to view details of the selected project and drawing. To do so,
select a project or drawing from the Projects rollout and then choose the Details button
from the Details/Preview rollout in the PROJECT MANAGER; details of the selected
project or drawing will be displayed in the Details rollout. Whenever you select a drawing file,
its details get updated and remain visible till you select a new drawing file. The information that
will be displayed in the Details rollout includes status, description if added, file name, file
location, file size, date when the file was last saved, the name of the user who modified the file
last, and so on, refer to Figure 2-41.

Note
You can switch/move from one drawing to another by using the wp and down arrow keys.

Preview
The Preview button is used to display preview of the selected drawing in the Preview
E rollout. To preview a selected drawing, select the drawing from the Projects rollout and
then choose the Preview button from the Details/Preview rollout; the image of the
selected drawing will be displayed in the Preview rollout, refer to Figure 2-42. The image of the
selected drawing will be visible till you select another drawing from the Projects rollout. You
can use up and down ARROW keys to view all drawings of a project.

Note

As discussed in the previous section, you can use the PROJECT MANAGER to preview drawings.
When you scroll through the drawings in the PROJECT MANAGER using the up and down
ARROW keys, the preview or the details of the drawing get displayed in the PROJECT MANAGER.

Location View TAB

The options in the Location View tab of the PROJECT MANAGER are used to display and filter
the components based on the installation and location codes, display details and connections
of the components, and so on. Figure 2-43 shows the PROJECT MANAGER with the Location
View tab chosen. The options in this tab are discussed next.
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Filter by Installation and Location
@ »| This button is used to filter components in the Component Tree as per the installation
and location codes. When you click on the down arrow of this button, a flyout is displayed,
refer to Figure 2-44. This flyout consists of various combinations of installation and
location codes available in the active project as options. You can click on any of these options
to view or hide components in the Component Tree based on the requirement.

Search field Display Details and
Filter by Connections
Installation Refresh Tree far
and Location Local Char?ges |—Help

» |

L] @ v
3 |Type here to search... |

Q7

Projects

NFPAdemo.wdp
NFPAdemo Component
I Tree
o ¢ PROJECT MANAGER
g v v oy ‘ |
£ 9 2BE®
-é [ Select all
3 =(7+07)

=(?7)+FLOOR
=(77)+JBOXL
=(?7)+ MACHINE
=(77}+MCABS
=(?7)+0PSTA3

» PROJECT MANAGER

OK Cancel

Figure 2-43 The PROJECT MANAGER  Figure 2-44 Flyout displayed on choosing the
with the Location View tab chosen Filter by Installation and Location button

Refresh Tree for Local Changes
#~| Thisbutton is used to refresh the Component Tree, the Details pane, and the Connections
s pane based on the changes made in the current session.

Search Field

This field is used to specify the search text such as component name, installation code, or
location code.

Go

This button is used to search the text entered in the Search field.
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Component Tree

The Component Tree displays a list of all the components available in the active project. It has
various nodes. The main node is the active project node. When you expand this node, a node
representing installation code will be displayed. When you expand this node, all location code
nodes will be listed as separate nodes. You need to expand these nodes to view the components
with these installation/location codes as separate nodes. This list also includes PLC modules,
connectors, cable markers, and terminals. You need to expand these component nodes in the
Component Tree to view pin information of the components, refer to Figure 2-45. When you
hover the cursor over a component, the detailed information about the component such as
catalog information, assembly code, description is displayed, refer to Figure 2-46.

B FLOCOR
B © DIsC207
& (77) {Pin 1}
& (77) {Pin 2}
& (77) {Pin 3} O PLCEDZ
& (77) {Pin 4} O PLCE22
& (22} {Pin 5} © PL{ Electrical Only Component Tag: PLCA02
& (7) {Pin 6} O TB{ Manufacturer: AB
© DIsC211 © TB| Catalog Number: 1771-1AD
© DIsc215 © TB{ Assembly Code:
B © MTR208 © TB{ Description:
& (77) {Pin 1} O T8 RACK 00
& (77) {Pin 2} Bl FLOOR |sLOT3
o (27) {Pin 3} O DI 120V INPUTS
& (77) {Pin 4} O Dlstziz
O MTR212 O [IsC215
B O MTR216 O MTR208

Figure 2-45 The pin information of  Figure 2-46 The detailed information
the components of the component

You will notice that there are different icons on the left of each component. The significance of
these icons is explained in Table 2-1.

Table 2-1 The significance of icons

AutoCAD Electrical component not linked to an Irventar component

Inventar component not linked to an AutaCAD Electrical component

Linked AutaCAD Electrical and Inventor components with no mismatches in data

Linked AutaCAD Electrical and Inventor components with some mismatch between the data

AutoCAD Electrical cable not linked to Inventor cable

Inventor cable not linked to AutoCAD Electrical cable

Linked AutoCAD Electrical and Inventor Cable with no mismatches in data

Mliv|en| 8B % |0

Linked AutoCAD Electrical Inventor cable with some mismatch between the data

To expand or collapse all the nodes in the Component Tree, right-click on any of the installation
or location nodes and choose the respective option from the shortcut menu displayed, refer to
Figure 2-47.

When you right-click on an individual component node, a shortcut menu will be displayed, refer
to Figure 2-48. Choose the Surf option; the Surf dialog box will be displayed. In this dialog box,
related references of the component are displayed. The options in this dialog box are discussed
in detail in Chapter 6.
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x o r » ]
!~ R i E=a
[ 9 elo - =10
5 |Type here to search... | Es3 |Typ-e here to search... |
NFPAdemo.swdp NFPAdemo.wdp
B (77 B 7
7 27
B FLeoR Bl FLOCR
Expand all Q DIsf
Collapse all o DIS;@
Q DISC

Figure 2-47 The shortcut menu displayed on  Figure 2-48 The shortcut menu displayed on
right-clicking an installation/location node right-clicking a component node

Display Details and Connections
This button is used to expand the PROJECT MANAGER with two additional tabs: Details
and Connections. These two tabs are discussed next.

Details Tab

When you choose this tab, the Details pane is displayed. Choose the installation or location
node in the PROJECT MANAGER; a list of components in this node will be displayed in a grid
in the Details pane, refer to Figure 2-49. You need to scroll horizontally in the pane or increase
the size of the pane by stretching it horizontally to view all the columns in the grid. If you select
an individual component node in the PROJECT MANAGER, the tabular information of only that
component will be displayed in a grid.

: @~ s ()| || Details | Connections
#* ‘Type here to search... | (i) Infarmation updated at 8/16/2018 %:50:34 AM Export g
NFPAdemo.wdp g
m L Tag Manufacturer  Catalog Number Description 1 Ter| | =
=2 gFPE'::]e’““ = O [Disca07 a8 194E-A25-1753
o ‘ ‘ O |pisca11[a8 194E-A25-1753 —
FLOOR. | © |Disc215 a8 194E-A25-1753
1BOX1 © |mTR208 A8 1320RS-ZAD0518VNH | CONVEYOR MOTOR E
B MACHINE © [MTR212 |AB 1329RS-ZA00518VNH | HYDRAULIC MOTOR 3
;ﬂﬁgt O [MTR216 [ A8 1320R5-ZA00518VNH | INDEXING MOTOR E
215C8L O|CA -
B O FLse08 O [Pl207  [HuBBELL MRMS22425 N
2\9 7 {Pin 1) O [pL211
& N Pin 2 O |pL21l [HuBBELL MRMS22425
O FL3614 o lpias
gﬁgg o p21s [HusseL MRMS22425
:\6 7 {Pin 1)
© (77) {Pin 2}
. B O L5408
5 G enEiny
= G A Pin 2
S B O 15612
= 4 o2 pin 1)
= S eNPing
= O 15613 - .
= M O 1e7As = 1] | 7]

Figure 2-49 The Details pane with tabular information

If you right-click on the column name of the grid, a shortcut menu will be displayed, refer to
Figure 2-50. The options in this shortcut menu are used to add or remove columns from the
Details pane and to restore default number of columns. Similarly, if you right-click on the cell(s)
or row(s) in the grid, a shortcut menu will be displayed, refer to Figure 2-51. This shortcut menu
consists of two options: Copy and Surf. The Surf option is already discussed in the Component
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Tree. The Copy option will be activated only when you select cell(s) or row(s) in the grid. Using
this option, you can copy the content of the selected cell(s) or row(s).

The Export button located at the top right corner of the Details pane is used to export the
data in the grid to .xIs or .csv file. Note that in the export process only the data that is currently
displayed in the grid will be exported.

Details | Connections
(i) Information updated at 8/16/2018 9:50:34 AM Export
Tan Manufacturer Catalon Numhber [}eg([ipﬁun 1 Ter
oo v Tag
O |DIS| v  Manufacturer
@] b5 +  Catalog Mumber
] M1 Description 1 PVEORMOTOR Details | Connections
O [wr| ¥ Deseription DRAULIC MOTOR
©Q |MT| ¥ Terminal Strip EXING MOTOR (i) Information updated at 8/16/2018 9:50:34 AM Export
O |PL2| ¢ Item Number -
o |pLZ Tag | Manufacturer  Catalog Number Description 1 Ter
Assembly Code ol | |
o le2 | \25-1753
SIEE Categery o |oiy Copy Cl+C 25-1753
O |PL2 Rating 1 O |DIS 5 Surf \25-1753
O pL2 M o lna FAanns1 euniu | FAnvcvnD sanTND
Ore..
Restare all columns to defaults

Figure 2-50 The shortcut menu displayed — Figure 2-51 The shortcut menu displayed on
on right-clicking on the column name right-clicking on the cell(s) or row(s) in the grid

Connections Tab

When you choose this tab, the Connections pane is displayed. Choose the installation or location
node in the PROJECT MANAGER; information about wiring of the components in this node
will be displayed in a grid in the Connections pane, refer to Figure 2-52. You need to scroll
horizontally in the pane or increase the size of the pane by stretching it horizontally to view all the
columns in the grid. If you select an individual component node in the PROJECT MANAGER,
the information regarding that component will only be displayed in the grid.

x -
W @ b : Details | Connections
5 |Typeheretc search... | (i) Information updated at 8/16/2018 9:50:34 AM Export | | | £
NFPAdemo.wdp =
o Wire Number From Location | From Component | From Pin | To L <
3] 3 H _
gFP(’:S]E’”“ — © [207a FLOOR PL207 : 1] 1 FLodEl
= @) ‘ ‘ O [2078 FLOOR DISC207 FLOC =
FLOOR - © | 2088 FLOOR DISC207 FLOC
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Figure 2-52 The Connections pane with tabular information



Working with Projects and Drawings 2-39

If you right-click on the column name in the grid, a shortcut menu will be displayed, refer to
Figure 2-53. The options in this shortcut menu are used to add or remove columns from the
Connections pane and to restore default number of columns. Similarly, if you right-click on
the cell(s) or row(s) of the grid, a shortcut menu will be displayed, refer to Figure 2-54. This
shortcut menu consists of two options: Copy and Surf. The Surf option is already discussed in
the Component Tree. The Copy option will be activated only when you select cell(s) or row(s)
in the grid. Using this option, you can copy the content from the selected cell(s) or row(s).

Details | Connections

(i) Information updated at 8/16/2018 2:50:34 AM

Wi
B V' Wire Number

0 | 207
Q| 207 From Installation
O 208 v From Location
| v From Component
O [ 208 -
o |20 ¥ From Pin
©|211 v ToPin
Q211 v To Component Details | Connections
g ;E v [To Location (3) Information updated at 8/16/2018 9:50:34 Al
z
- To Installation Wire Number From Location From C
Q| 213 I
e Q
O |217 More... S Copy Cirl+C
O [219 Restore all columns to defaults © [2088 | o surf
(8]

Eal

Figure 2-53 The shortcut menu displayed on Figure 2-54 The shortcut menu displayed on
right-clicking on the column names right-clicking on the cell(s) or row(s) of the grid

The Export button located at the top right corner of the Connections pane is used to export the
data in the grid to .xls or .csv file. Note that in the export process only the data that is currently
displayed in the grid will be exported.

a

Note

1. Ifthe project you are working is an electromechanical project and you are linking it with Autodesk
Inventor, some additional buttons will be available in the PROJECT MANAGER such as Filter
the view by link status, Refresh the data from Inventor, and so on. Also, some additional
shortcut menu options will be available for the grid.

2. You can link AutoCAD Electrical component to the Inventor part or vice-versa. 1o do so,
right-click on Inventor part or AutoCAD Electrical part and choose Assign to Existing in
Component Tree from the shortcut menu displayed. The selected components will be linked with
some differences. You need to resolve these differences using the Details and Connections pane
in the Location View tab.

3. 1o insert connector from the Location View tab in the Inventor assembly of the electromechanical
project, right-click on a node or a connector and then choose Insert Connector (From List) from
the shortcut menu displayed.

TUTORIALS
Tutorial 1

In this tutorial, you will create a new project and add project description to it, refer to Figure 2-55.
You will also create a new drawing in the project. (Expected time: 10 min)

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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The following steps are required to complete this tutorial:

Create a new project.
Open the CADCIM project.
Create a new drawing.

Creating a New Project

1.

Start AutoCAD Electrical 2019 by choosing
Start > All Programs (or Programs,
if you are working with Windows XP
Classic appearance mode) > Autodesk >
AutoCAD Electrical 2019 > AutoCAD
Electrical 2019(Windows 7). Alternatively,
double-click on the shortcut icon of AutoCAD
Electrical 2019 on the desktop of your computer
to start AutoCAD Electrical 2019.

In the AutoCAD Electrical 2019 interface,
click on the Start Drawing window. The
PROJECT MANAGER is displayed by default
on the left of the screen. If it is not displayed,
choose the Manager tool from the Project
Tools panel of the Project tab. Alternatively,
choose the Project Manager tool from the
ACE:Main Electrical 2 toolbar to display the
PROJECT MANAGER.

In the PROJECT MANAGER, make sure the Projects tab is chosen. Next, choose the New
Project button; the Create New Project dialog box is displayed, as shown in Figure 2-56.

P PROJECT MANAGER

BEMSEES -
[capam [
Projects =

=t CADCIM
R C02_tut0l.dwg
=i EXTRA LIBRARY DEMO
) e NFPADEMO

-t POINT2POINT

- WDDEMO

Details B -

Description: 3 Phase Motors -
Description: Motor Control Circuit
Description:

File Name: C02_tut01.dwg

Location: C:\Users\CADCIM
\Documentsh\AcadE 2019\ AeData
\proj\CADCIM

File Size: 47KB (48539 bytes)
Last Saved: 8/17/2018 11:16:55 AM
Last Edited By: CADCIM | 4

Figure 2-55 The PROJECT MANAGER
displaying the CADCIM project and its

description

Create Mew Project

Name:

==

Location:
ChlUsers\CADCIM\Documents*AcadE 2019\A=Data"proj.

Create Folder with Project Name
C:AUsers\CADCIM Documents' AcadE 2015 AeData'proj'

Copy Settings from Project File:

Descriptions...

CUsers\CADCIM\DocumentstAcadE 2015\AeData"proj NFP Ademo"NFPAdemo wdp

Browse. ..

QK - Properties.... OK

[ Cancel ] [

Help |

Figure 2-56 The Create New Project dialog box

4. Enter CADCIM in the Name edit box.

Projects

Location Yiew
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5. Choose the Browse button; the Browse For Folder dialog box is displayed. By default, the
Proj folder is selected in this dialog box. Choose the OK button; the location of the project
is automatically displayed in the Location edit box.

6. Select the Create Folder with Project Name check box, if not selected.

7. By default, the name and path of the existing project is displayed in the Copy Settings from
Project File edit box as c:\Users\User Name\Documents\AcadE 2019\AeData\proj\NFPAdemo)
NFPAdemo.wdp. 1f it is not displayed, choose the Browse button; the Select Project File
dialog box is displayed. Select the NFPADemo folder and then select the NFPAdemo.wdp
project file.

Next, choose the Open button; the path and name of the existing project is displayed in
the Copy Settings from Project File edit box.

8. Choose the Descriptions button from the Create New Project dialog box; the Project
Description dialog box is displayed.

9. Enter the following information in the Project Description dialog box, as shown in
Figure 2-57.

LINE1= CADCIM
LINE2= AutoCAD Electrical
LINE3= Sample Project

LINE4=1

LINE5= 17/08/2018
LINE6= Sham
LINE7= John
LINE8= Crystal
LINE9= 1.00

Next, select the in reports check box corresponding to each of these lines to include this
description in the reports, refer to Figure 2-57.

Note

The information that you enter in the description lines of the Project Description dialog box will
be displayed at a particular location in the title block of the drawing files of the CADCIM project,
as shown in Figure 2-58. The title blocks will be discussed in detail in Chapter 12.

10. Choose the OK button from the Project Description dialog box to save the changes made
in this dialog box.

11. Choose the OK button from the Create New Project dialog box. You will notice that
the CADCIM project appears in bold text at the top of the project list displayed in the
PROJECT MANAGER, refer to Figure 2-59.

12. Next, select the CADCIM project from the PROJECT MANAGER.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Project Description (for report headers and title block update)
Line1 [cADCim | [V]in reports
Line2 [AutoCAD Blectrical | ¥inreports
Line3 [Sample Project | [V]in reports
Lined |1 | [¥]in reports
Line5 [17/08/2018 | @inreporis
Line6 |Sham | [¥]in reports
Line7 |John | [¥]in reports
Lined |cp,.5ta| | [¥]in reports
Lins9 [loo | ts
Line10 | | [Cin reports
Line11 | | [Tlin reports
Line12 | | [[lin reports

Figure 2-57 The Project Description dialog box

13. Choose the Details button from the Details/Preview rollout. You will notice that the project
description/information entered in the first nine lines of the Project Description dialog box
is displayed in the Details/Preview area, as shown in Figure 2-59.

: BERSyERES

#| [capam -] £
2
- -
Projects £
-t CADCIM
- tei| EXTRA LIBRARY DEMO
- el NFPADEMO
s POINT2POINT E
4 WDDEMO Z
£
CADCIM | Line1 8
AutoCAD Electrical —— Line?
Sample Project — 1 |ine3 = —
3 Phase Motors [eras EE -
20194R23.0%enul\Supportiuser  +
\CADCIM.mdb
- |ENCINEER - — R— ], [-1: Line1: CADCIM
Line6 sham _Crystal _ Line 2: AutoCAD Electrical
Lined —f— 1 John ] Line? Line 3: Sample Project
) == T 1 Lined:1 T
Lined —F 100 17,/08/2018 Line& E| Lines:17/08/2018
oG WO % Line &: Sham
O ?‘ % Line7: Jehn =
£ Line 8: Crystal
SHEET NO I Line 9:1.00
or1 | g |
A

Figure 2-58 The title block showing the Figure 2-59 The PROJECT MANAGER
description entered in the Project Description  displaying the CADCIM project and its description
dialog box

Note

1. It is recommended to save all the tutorials in the forthcoming chapters in the CADCIM project.
2. If the CADCIM project is not displayed in the Projects rollout of the PROJECT MANAGER,
select the Open Project option from the Project selection drop-down list; the Select Project
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File dialog box is displayed. Select the Proj folder from the Look in drop-down list and then
double-click on the CADCIM folder name. Next, select the CADCIM file and choose the Open
button; the CADCIM project is displayed in the Projects rollout and it becomes the active project.

Creating a New Drawing

1. In the PROJECT MANAGER, choose the New Drawing button; the Create New

Drawing dialog box is displayed, as shown in Figure 2-60.

Create Mew Drawing

Drawing File

Name:
Template:
|| For Reference Only

Location: CAUzers\CADCIM \Documents\AcadE 2015 AeData"projCADCIM
C:AUsers\CADCIM'Documents' AcadE 201 9\Ae Data pro\CADCIM

Browse...
Browse...

|EC - Style Designators
Project Code:

Installation Code:

Description 1: -
Description 2: -
Description 3: -

X5

’ Drawing... ] [ Project... ]

Location Code:

’ Drawing... ] [ Project.... ]

Sheet Values
Sheet: Section:

Drawing: Sub-Section:

OK - Propeies... 0K | Cancel | [ Hep

Figure 2-60 The Create New Drawing dialog box

2. Enter C02_tut01 in the Name edit box. Next, choose the Browse button; the Select
template dialog box is displayed. In this dialog box, select ACAD_ELECTRICAL.dwt from
the list displayed and then choose the Open button; the name and path of the template is

displayed in the Template edit box.

3. Clear the For Reference Only check box, ifit is selected. Next, choose the Browse button
available on the right of the Location edit box; the Browse For Folder dialog box is displayed.
By default, the CADCIM project is selected. Choose the OK button; the location of the

drawing is automatically displayed in the Location edit box.

4. Enter 3 Phase Motors in the Description 1 edit box.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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5. Enter Motor Control Circuit in the Description 2 edit box and enter 01 in the Drawing

edit box of the Sheet Values area.

Choose the OK button from the Create New Drawing dialog box; you will notice that
the drawing that you created gets added to the active project. To view the drawing that
you created, double-click on CADCIM in the PROJECT MANAGER; the drawing list is
displayed and the drawing C02_tut01.dwg appears in bold text in the PROJECT MANAGER.
In this case, the active project is CADCIM; and therefore, the drawing gets added to this
project. Click on the drawing; the details and the preview of the drawing are displayed in
the PROJECT MANAGER, as shown in Figures 2-61 and 2-62.

Preview BE -

Details 2E -
Status: Locked by CADCIM(CADCIM-PC) =
Sheet: B
Description: 3 Phase Motors
Description: Motor Control Circuit
Description:

File Name: C02_tut01.dwg

m

Location: C:\Users\CADCIM\Documents
‘\AcadE 2019\ AeData\proj\CADCIM

File Size: 4TKB (48539 bytes)
Last Saved: 8/17/2018 11:16:55 AM
Last Edited By: CADCIM

Figure 2-61 The Details rollout displaying ~ Figure 2-62 The Preview area displaying
the description of CO2_tut01.dwg the preview of CO2_tut01.dwg

Tutorial 2

In this tutorial, you will add and remove drawings from the CADCIM project and replace the
drawings of the POINT2POINT project with the CADCIM project that you created in Tutorial 1
of this chapter. (Expected time: 15 min)

The following steps are required to complete this tutorial:

Add drawings from the existing project.
Remove the drawing.
Replace the drawing.

Adding Drawings from the Existing Project

1.

Right-click on the CADCIM project; a shortcut menu is displayed. Choose the Add Drawings
option from the shortcut menu; the Select Files to Add dialog box is displayed.

Select the Proj folder from the Look in drop-down list; a list of all the projects saved in this
folder is displayed. Next, double-click on the NfpaDemo folder from the Select Files to
Add dialog box; the drawings present in this folder are displayed.

Press SHIFT/CTRL and select the DEMOO0I, DEMO02, DEMO03, DEMO04, and DEMOO05
drawings. Next, choose the Add button; the Apply Project Defaults to Drawing Settings
message box is displayed.
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4. Choose the Yes button from this message box;

Removing the Drawing
1.

the selected drawings are added to the BHRSEEES -

CADCIM project, as shown in Figure 2-63. lc":chil |:| %

El-t= CADCIM o
1 C02_tutdl.dwg

1 DEMO01.DWG

1 DEMO02.DWG

1 DEMO03.DWG -

1 DEMO04.DWG

1 DEMO05.DWG

RA LIBRARY DEMO

Right-click on the DEMOO0I1.dwg drawing
and then choose the Remove option
from the shortcut menu displayed; the
PROJECT MANAGER - Remove Files
message box is displayed. Choose the Yes
button in this message box; the DEMOOI.
dwg drawing is removed from the drawing  Figure 2-63 The PROJECT MANAGER
list, see Figure 2-64. displaying the CADCIM project with the
drawings added to it

m

Location View

Replacing the Drawing

1.

To replace the DEMO02.dwg drawing of the CADCIM project with the Connectordwg of
the POINT2POINT project, right-click on the DEMO02.dwg drawing; a shortcut menu is
displayed. Choose the Replace option from the shortcut menu; the Select Replacement
Drawing dialog box is displayed.

Select the Proj folder from the Look in drop-down list. Next, double-click on the Point2Point
folder; the Connectordwg drawing is displayed in the Select Replacement Drawing dialog
box.

Select the Connectordwg drawing from this dialog box and choose the Select button; the
Apply Project Defaults to Drawing Settings message box is displayed. Next, choose the
Yes button; the DEMO02.dwg is replaced with the Connectordwg drawing in the CADCIM
project, as shown in Figure 2-65.

BERSsEES -@

[capcm -] = )
— o] & BERSIEES O
o |capam -]
-l CADCIM -
Tl Prajects =

== CADCIM
@ C02_tut01.dwg

'™ Connector.dwg
DEMO03.DWG E

m

Location Wiew

-] EXTRA LIBRARY DEMO
-] MFPADERMO
et POTMT2POTRT i r

- EXTRA LIBRARY DEMO
(- e NFPADEMO i

Figure 2-64 The PROJECT MANAGER Figure 2-65 The PROJECT MANAGER displaying
displaying the CADCIM project after removing  the CADCIM project with the DEMOO2.dwg drawing
the DEMOOI.dwg drawing replaced by the Connectordwg drawing

Tutorial 3

In this tutorial, you will create a subfolder within a CADCIM project and configure the drawing
list display for the CADCIM project. (Expected time: 15 min)

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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The following steps are required to complete this tutorial:

a. Create a subfolder.
b. Configure the drawing list display.
Creating a Subfolder
In this section, you will create a subfolder in the CADCIM project that is created in Tutorial 1.
1. Make sure that the CADCIM project is activated BERSCERS @
in the PROJECT MANAGER. Next, right-click CADCIM - g
on it; a shortcut menu is displayed. Projects - E“
- CADCIM - 7
2. Choose the Add Subfolder option from the ™ Connectar.dig I
shortcut menu; a subfolder with the name NEW 3 DEMOD3.DWG
FOLDER is created within the CADCIM project. B8 DEMOD4.DWG =l |z
Rename it as TUTORIALS. ™ DEMODS.DWG =
=-£ TUTORIALS B NE-
3. Drag and drop the C02_tut0I.dwg drawing 8 C02_tut0l.dwg k]
created in Tutorial 1 on the TUTORIALS #=| EXTRA LIBRARY DEMO
subfolder; the CO2_tut01.dwg drawing is moved to it MERATERAC =

the TUTORIALS subfolder, refer to Figure 2-66. Figure 2-66 The C02_tut01.dwg moved

TUTORIAL
Note to the TUTORIALS subfolder

1. In AutoCAD electrical, all projects and its subfolders names are displayed in uppercase.

2. You can collapse the CADCIM project by right-clicking on its name and choosing the Collapse
All option from the shortcut menu displayed.

Conflgurmg the Drawing List Display

Choose the Drawing List Display Configuration button from the PROJECT MANAGER;
the Drawing List Display Configuration dialog box is displayed. You will notice that only
the File Name is displayed in the Current Display Order area.

Select Drawing Number(%D) from the Display Options area and then choose the >>
button; Drawing Number(%D) is moved to the Current Display Order area. Similarly,
select Drawing Description 1 from the Display Options area and choose the >> button;
Drawing Description 1 is moved to the Current Display Order area. Next, choose the OK
button to close the Drawing List Display Configuration dialog box.

You will notice that drawing numbers are added to the first four drawings in the CADCIM
project and description is added to the CO2_tut01.dwg.

Tutorial 4

In this tutorial, you will copy an existing project with the name Copy_Point2Point and add
three drawings into it. Next, you will find the list of drawings that have different settings. You

will also compare and match the settings of one of the added drawings with the copied project.

(Expected time: 15 min)
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The following steps are required to complete this tutorial:

Copy the Point2Point project.
Add the drawings.
Find the Exception list and compare the settings.

Copying the Point2Point Project

1.

Choose the Copy tool from the Project Tools panel of the Project tab; the Copy Project:
Step 1 - Select Existing Project to Copy dialog box is displayed, as shown in Figure 2-67.

Copy Project: Step 1 - Select Existing Project to Copy @

Enter existing project name Copy Active Project

Mote: if the active drawing is one of those to be copied to a new project:
1. Cancel now.
2. Open a different or a new drawing.
3. Re-start this command.

[ ok | [canesl | [ Hep |

Figure 2-67 The Copy Project Step 1 - Select Existing Project to Copy dialog box

Choose Browse from this dialog box; the Select existing project to copy dialog box
is displayed. In this dialog box, double-click on the Point2Point folder and then select
Point2Point.wdp file displayed, refer to Figure 2-68. Next, choose the Open button; path
of the Point2Point.wdp file is displayed in the edit box of the Copy Project: Step 1 - Select
Existing Project to Copy dialog box.

A Select existing project to copy @

Look in: | Paint2Pairt - G ? * [E~

Files of type: | *wdp v] [ Cancel ]

| locate | [ FindFie.. |

Figure 2-68 Selecting the Point2Point.wdp file

Now, choose OK from this dialog box; the Copy Project: Step 2 -- Select path and name
for new project dialog box is displayed. Choose the Up One Level button from this
dialog box and then choose the Create New Folder button; the New Folder is added

to the Proj folder. Next, rename the new folder as Copy_Point2Point.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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4. Double-click on the Copy_Point2Point folder in the Copy Project: Step 2 -- Select path
and name for new project dialog box and then enter Copy_Point2Point in the File name

text box, refer to Figure 2-69.

A Copy Project: Step 2 -- Select path and name for new project @
Savein: || Copy_Point2Point - QT e
MName : Date modified Ty

Me items match your search.
4 | i 3
Fle pame:  Copy_Point2Poirt -
Save as type: [‘_wdp v] [ Cancel ]

Figure 2-69 The Copy Project: Step 2 -- Select path and
name for new project dialog box

5.  Now, choose the Save button;

the Select Drawings to Process dialog box is displayed, as

shown in Figure 2-70. In this dialog box, choose the Do All button and then the OK button;
the Copy Project: Step 4 -- Enter Base Path for Project Drawings dialog box is displayed.

Select Drawings to Process

EX5)

@ Drawing (7 Description

Ref Subfolder

Section  Sub-Section Project Drawing List

ChUsersNCADCIM Documents'...eData'\ProjPoint 2Point \Connecty

[T | 3

&  Process f Baast

" n-select by Section./sub-section ] [ by Subfolder

Ref Subfolder

Section  Sub-Section Project Drawing List

|

n 2

Select from the top list,
insert into the bottom list.

Figure 2-70 The Select Drawings to Process dialog box



Working with Projects and Drawings 2-49

6. In this dialog box, the edit box located at the top displays default path for the project
drawings. Choose OK from this dialog box; the Copy Project: Step 5 -- Adjust new drawing
file names dialog box is displayed, as shown in Figure 2-71.

7. Choose OK from this dialog box; the Copy_Point2Point project is added to the Projects
rollout of the PROJECT MANAGER. Also, the drawings in the Copy_Point2Point project
get saved in its project folder and this project becomes an active project.

Note
1o change the name of drawings in the copied project, select drawings one by one in the Copy
Project: Step 5 -- Adjust new drawing file names dialog box and then choose Edit.

Adding the Drawings

1. Right-click on the Copy_Point2Point project in the PROJECT MANAGER; a shortcut menu
is displayed. Choose the Add Drawings option from the shortcut menu; the Select Files to
Add dialog box is displayed.

Copy Project: Step 5 -- Adjust new drawing file names @

C:/Users/CADCIM/Documents,/Acade 2015/AeData/Proj/Copy_Point 2Point/Connector.dwg

Figure 2-71 The Copy Project: Step 5 -- Adjust new drawing file names dialog box

2. Inthis dialog box, choose the Up one level button; the
Proj folder is displayed in the Look in drop-down
list. Next, double-click on the NfpaDemo folder; the
drawings present in this folder are displayed. Press
SHIFT/CTRL and select the DEMOO7, DEMOOS,
and DEMO09Y drawings.

BEESZREEE -(
| COPY_POINT2POINT [-|
Projects =
=-f=il COPY_POINT2POINT -

Lo Connector.dwg - W1234
% DEMO07.DWG - 0207

™ DEMO0S.DWG-0208 |2
% DEMO09.DWG - 0209

4. Choose the Add button; the Apply Project Defaults -

. . .. -l CADCIM

to Drawing Settings message box is displayed. 5 EXTRA LIBRARY DEMO
[

4

=i NFPADEMO

| i ] 3

5. Choose the No button from this message box; the
selef:ted drawings are a}dded to the C}opy_Poigt2Point Figure 2-72 The Copy_Point2Point
project, as shown in Figure 2-72. If the drawings are
not displayed in the Copy_Point2Point project,
choose Refresh from the PROJECT MANAGER.

project with the drawings added to it

Finding the Exception List and Comparing the settings
1. Right-click on the Copy_Point2Point project and choose Exception List from the shortcut
menu displayed; the Properties Exception List: COPY_POINT2POINT dialog box is

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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displayed, as shown in Figure 2-73. This dialog box lists the drawings which have different
properties than the project default properties.

Properties Exception List: COPY_POINTZPOINT

File Name: Connector.dwg
Status: Locked by CADCIM{CADCIM-PC)

File Name: DEMOO7.DWG
Status: Accessible

File Name: DEMO08.DWG
Status: Accessible

File Name: DEMOOS.DWG
Status: Accessible

Location: C:\Users\CADCIM\Documents®Acade 2015%Ae Data"Proj*\Copy_Point 2P oint

Location: C:\Users\CADCIM \Documents®\Acade 2015Ae Data'Proj'\NpaDema

Location: C:%\Users\CADCIM'DocumentsAcade 201944 Data'Proj.NfpaDema

Location: C:\Users\CADCIM'DocumentstAcade 201944 Data"ProjNfpaDema

These drawingis) have different properties than the project defaults. Use the Settings
I-_\ Compare funiction to display differences.

=)

Figure 2-73 The Properties Exception List: COPY_POINT2POINT dialog box

2. Select the DEMO007.DWG from the Copy_Point2Point project in the Projects rollout of the
PROJECT MANAGER and right-click; a shortcut menu is displayed. Choose Properties
from the shortcut menu; a cascading menu is displayed. Choose Settings Compare from
the cascading menu; the Compare Drawing and Project Settings: DEMO007.DWG Versus
COPY_POINT2POINT dialog box is displayed, as shown in Figure 2-74.

Compare Drawing and Project Settings: DEMO07.DWG Versus COPY_POINT2POINT (23]
() Show All
Settings Description Drawing Project
Component tags: R=reference, S=sequential based R s
Wire layers BLK® WHT* RED* GRN* WIRES |WIRES
XREF_GRAPHIC 1 0

Lok ]

[ concsl | [ Heb |

Figure 2-74 The Compare Drawing and Project Settings: DEMO007.DWG
Versus COPY_POINT2POINT dialog box
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You will notice that this dialog box displays the number of drawing settings that are
different from its project. First entry in this dialog box indicates that component tags of the
DEMOO007.dwg are reference based and component tags of the Copy_Point2Point project
are sequential in order.

3. Select the first entry and choose the Match Drawing button from the Compare Drawing
and Project Settings: DEMO007.DWG Versus COPY_POINT2POINT dialog box. Next,
choose OK; the component tag settings of the project are matched with the DEMOO0O7.
dwg file. To confirm this, repeat step 2. You will notice that component tag settings are not
displayed any more in the list.

Tutorial 5

In this tutorial, you will extract component information and connection details of the CADCIM
project to an external file using the Location View tab in the PROJECT MANAGER.
(Expected time: 15 min)

The following steps are required to complete this tutorial:

a. Surf the component.
Extract component information.
c. Extract connection details.

Surfing the Component

1. Make sure the CADCIM project is activated. Choose the Location View tab from the =
PROJECT MANAGER. Next, choose the CADCIM node from the PROJECT
MANAGER. Next, choose the Display Details and Connections button; the
PROJECT MANAGER is expanded with the Details tab activated, as shown in Figure 2-75.

You will notice that the component information is displayed in the Details pane in the grid.

Q- 2 2]l @ ||| petails |_connections x
G| [Type here to search... Go || || (@) Information updated at 8/21/2018 10:47:02 AM Export | | | ¥
g‘ CADCIMwdp

el cAociv |

Tag Manufacturer | Catalog Number Description 1 Terminal Strip _ Item Number Location
DL D SUB 9 PINL
D1 D SUB 9 PINL
D2 D SUB 15 PIN:L
D2 D SUB 15 PIN:L
DS |ALPHA 1179C D SUB CABLE

Location Wiew

2 MOLEX_SL_MALE_10_PIN:2
MOLEX_SL_MALE_10_PIN:2
3 MOLEX_SL_MALE_4_PIN:1
3 MOLEX_SL MALE 4 PIN:L
4 TRANSFORMER:L

4 TRANSFORMER:L

5 MOLEX_SL MALE 4 PIN:2
5 MOLEX_SL MALE 4_PIN:2
12 MOLEX_SL_MALE 10 PIN:L
12 MOLEX_SL_MALE 10 PIN:1
Pl CN3 MATEL

Pl CN3 MATEL

pjo|ojo|o|o|o|e|e|ole|o]e|e|o|odvo|o|o|e

PROJECT MANAGER

>

Figure 2-75 Expanded PROJECT MANAGER

2. Scroll down in the PROJECT MANAGER and select LS406 from the Tag column. Next,
right-click on it; a shortcut menu is displayed, as shown in Figure 2-76.
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3. Choose Surf from the shortcut menu; the Surf dialog box is displayed, as shown in
Figure 2-77. Choose Go To from the Surf dialog box; the demo004.dwg file is opened with
LS406 zoomed in.

Surf (=50
L5406 references
Manufacturer:
Catalog:
Type Sheet Reference Installation Location
p MO 4, 406 MACHINE

€| m r

o SIEMENS B\ Show mre

o Ms M Edt [Catalog Check | [ Pan |
Q |L540 Copy Ctrl=C
o isad Delete [Fick Newlist | [ Zoomin |
Q
o

Surf
T
PRS504 | EATON Es : :
O [PRs505 |eaTON ES | GoTe | [ Cose | [ Hep | y

Figure 2-76 Shortcut menu displayed Figure 2-77 The Surf dialog box

Note
The options in the Surf dialog box are discussed in detail in Chapter 6.

Extracting the Component Information
1. Right-click on the Tag column in the grid; a shortcut menu is displayed. Choose More from
this shortcut menu; the Columns to display dialog box is displayed.

2. Scroll down in the Columns to display dialog box A Columns to display 5
and select the Category, Ratingl, Location and

Terminal Number check boxes, as shown in Description 1 :
Figure 2-78. Next, choose OK; the Category, | Terminal Strip
Rating1, Location and Terminal Number columns ftem Number |
are added to the grid in the Details tab. [C] Assembly Cade

Category

3. Choose Export from the PROJECT MANAGER;the Rating 1
Save As dialog box is displayed. Browse to c:| DR“”Q:"
Users\User Name\Documents\AcadE 2019\AeData\proj\ [ Terminal Numbes

CADCIM and choose Save; the ComponentDetails.csv [ Description 2
file is saved at the specified location. [ Description 3
[[] Installation
Extracting the Connection Details =

1. Choose the Connections tab in the PROJECT |
MANAGER; the PROJECT MANAGER is modified
with connection details of the CADCIM project
displayed in the grid.

OK | [ Cancel ]

Figure 2-78 The Columns to display
dialog box
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2. Right-click on the Wire Number column in the grid; a shortcut menu is displayed. Choose
More from this shortcut menu; the Columns to display dialog box is displayed.

3. Scroll down in the Columns to display dialog box and select the Wire Type, Wire Color,
and Wire Gauge check boxes. Next, choose OK; the Wire Type, Wire Color, and Wire
Gauge columns are added to the grid in the Connections tab.

4. Choose Export from the PROJECT MANAGER; the Save As dialog box is displayed.
Navigate to c:|Users\User Name\Documents\AcadE 2019\AeData\proj\CADCIM and choose Save;
the ConnectionDetails.csv file is saved at the specified location.

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1. Which of the following buttons in the PROJECT MANAGER is used to execute the pending

updates?
(a) New Project (b) Refresh
(c) Project Task List (d) Surfer
2. The option is used to plot all drawings of a project or a specified group of
drawings.
3. The option is used to create copies of an existing project with all the drawings

and related files.

4. The dialog box is used to edit the properties of a drawing.
5. Choose the button to preview a selected drawing.
6. You can add up to lines of description per page for each drawing in a project.

7. A project file is an ASCII text file. (T/F)
8. The PROJECT MANAGER is used to manage the project files only. (1/F)
9. A project file always consists of drawings placed in a single directory. (1/F)

10. You can switch between sequential drawings in an active project. (1/F)
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Review Questions

Answer the following questions:

1. Which of the following buttons is used to change the appearance of a drawing list displayed
in the PROJECT MANAGER?

(a) Plot Project (b) Project Task List
(c) Move Up (d) Drawing List Display Configuration

2. Which of the following options is used to add existing drawing(s) to a project?

(a) Descriptions (b) Add Active Drawing
(c) Add Drawings (d) Title Block Update

3. The Remove Drawings option is used both for removing and deleting a drawing file. (1/F)
4. You can close only the non-active projects. (1/F)

5. Projects can be closed by using the Project selection drop-down list. (T/F)

EXERCISES

Exercise 1
Create a new project with the project name NEW_PROJECT and add appropriate description to
it. (Expected time: 10 min)

Note
It is recommended to save all exercises of the forthcoming chapters in the NEW_PROJECT project.

Exercise 2

Create a new drawing with the name C02_exer02.dwg in the project created in Exercise 1 and
add appropriate description to it. (Expected time: 10 min)

Exercise 3

Using the Copy button, create a new project with the name COPY_PROJECT containing the
drawings and settings of any existing project. (Expected time: 10 min)

Answers to Self-Evaluation Test
1. C, 2. Plot Project, 3. Copy Project, 4. Drawing Properties, 5. Preview, 6. three, 7. T, 8. F,
9.F 10.T



